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RESUMEN 

El objetivo del siguiente trabajo fin de grado es modelar y simular dinámicamente 

una bicicleta de uso convencional, con el fin de realizar un análisis dinámico en 

profundidad sometiéndola a diversas situaciones. El principal software que se va a 

utilizar es MSC Adams, uno de los referentes en el campo de la simulación de la 

dinámica de sistemas multi-cuerpo. 

En primer lugar, se creará el modelo de la bicicleta mediante un diseño CAD 

obtenido de una comunidad de libre acceso, atendiendo a las proporciones de una 

bicicleta real y el peso del conjunto. Después se crearán los pares cinemáticos y 

restricciones necesarias para el correcto funcionamiento del modelo. En tercer 

lugar, se desarrollará el sistema de piñones, platos y cadena para transmitir el 

movimiento y someterlo a estudio. 

Una vez creado el modelo del conjunto, se someterá a diversas situaciones 

específicas para estudiar su dinámica, variando la pendiente del terreno y el 

desarrollo utilizado en la transmisión. 
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RESUM 

L'objectiu del següent treball fi de grau és modelar i simular dinàmicament una 

bicicleta d'ús convencional, per tal de realitzar un anàlisi dinàmic en profunditat 

sotmetent-la a diverses situacions. El principal programa que es va a utilitzar és MSC 

Adams, un dels referents en el camp de la simulació de la dinàmica de sistemes 

multi-cos. 

En primer lloc, es crearà el model de la bicicleta mitjançant un disseny CAD 

obtingut d'una comunitat de lliure accés, atenent a les proporcions d'una bicicleta 

real i el pes del conjunt. Després es crearan els parells cinemàtics i restriccions 

necessàries per al correcte funcionament del model. En tercer lloc, es 

desenvoluparà el sistema de pinyons, plats i cadena per transmetre el moviment i 

sotmetre-ho a estudi. 

Una vegada creat el model del conjunt, es sotmetrà a diverses situacions 

específiques per estudiar la seua dinàmica, variant la pendent del terreny i el 

desenvolupament utilitzat en la transmissió.  
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ABSTRACT 

The goal of the following final degree project is to model and simulate a 

conventional bicycle, in order to perform a dynamic analysis in depth submitting to 

various situations. The main software that will be used is MSC Adams, one of the 

leaders in the field of simulation of multi-body systems dynamics. 

First, the model of the bicycle will be created with a CAD design obtained from a 

free access community, taking into account the proportions of a real bicycle and the 

weight of the whole. After that, the kinematic pairs and restrictions necessary for 

the correct operation of the model will be created. In the third place, the system of 

cassette, chainrings and chain will be developed to transmit the movement and 

submit it to study. 

Once the model of the set has been created, it will be simulated in several specific 

situations to study its dynamics, varying the slope of the terrain and the 

development used in the transmission. 



12 

  



 

 

  

1 Memoria 
del 

proyecto 



14 

  



15 

1. INTRODUCCIÓN 

1.1. Contexto histórico 

Si nos preguntamos cuál es el origen de la bicicleta, tal vez debamos retroceder 

hasta el Antiguo Egipto. A lo largo de la historia se han encontrado jeroglíficos como 

los que aparecen en el obelisco de Luxor situado en París en los que se ilustran 

hombres montados en una barra horizontal apoyada sobre dos ruedas para 

desplazarse. También se han encontrado figuras similares de la época de los 

romanos en algunos frescos de la ciudad volcánica de Pompeya, incluso bocetos 

hechos por Leonardo da Vinci que se asemejan mucho a la bicicleta de hoy en día. 

 

ILUSTRACIÓN 1: 'BICICLETA DE LEONARDO DA VINCI' 

 

A principios del siglo XIX, el escocés Kirkpatrick MacMillan creó la primera 

bicicleta realmente manejable por una persona utilizando pedales, y no 

propulsándose con los pies en el suelo como se había hecho hasta el momento. A 

partir de este primer modelo se fueron haciendo sucesivas innovaciones y mejoras 

en el sistema de transmisión de movimiento, y en el año 1864 se inventó la primera 

que contaba con una cadena de transmisión. 

Tras muchas innovaciones y variaciones del modelo original de MacMillan, en el 

año 1885 el británico John Starley Kemp, considerado el padre de la bicicleta 

moderna, creó la ‘Rover Safety Bicycle’, con las dos ruedas del mismo radio, 

transmisión por cadena y engranajes, pedales y horquilla inclinada, modelo a partir 

del cuál se han desarrollado las bicicletas modernas de hoy en día. Once años 
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después, y tras el exitoso invento del neumático, el ciclismo pasó a declararse 

deporte olímpico en los primeros Juegos Olímpicos de la era moderna. 

 

ILUSTRACIÓN 2: 'ROVER SAFETY BICYCLE' 

 

Desde entonces, la bicicleta ha ido evolucionando hasta convertirse en lo que se 

conoce hoy en día: auténticas obras de ingeniería con miles de estudios a sus 

espaldas, alzándose como uno de los vehículos más utilizados por la población en 

todo el mundo. 

Existen múltiples modalidades de ciclismo de alto nivel, siendo las dos más 

conocidas y estandarizadas el ciclismo de montaña y carretera. En ambas 

modalidades han destacado varios españoles durante la historia, entre ellos, José 

Hermida, campeón mundial de ciclismo de montaña en diversas ocasiones. 

 

ILUSTRACIÓN 3: 'BICICLETA DE JOSÉ HERMIDA EN 2014' 
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También destaca Alberto Contador, retirado como ciclista profesional en el año 

2017 y conocido en el mundo del ciclismo como uno de los mejores escaladores 

(ciclistas especialistas en terrenos con un gran desnivel prolongado) de la historia y 

ganador de dos Giros de Italia, dos Tours de Francia y tres Vueltas a España. Ambos 

ciclistas han utilizado bicicletas del más alto nivel en cuanto a diseño y materiales, 

cuyo valor en el mercado superaría los diez mil euros. 

 

ILUSTRACIÓN 4: 'BICICLETA DE ALBERTO CONTADOR EN 2017' 

 

1.2. Estructura mecánica de la bicicleta 

A pesar de los múltiples tipos de bicicletas existentes en el mercado, hoy en día 

los componentes básicos de todas ellas son los mismos: 

• Cuadro: es el componente principal de la bicicleta y sirve de elemento de 

unión entre todos los elementos de la misma. Es el encargado de repartir 

el peso del ciclista al resto de componentes para lograr un correcto 

funcionamiento. Al ser la parte más voluminosa del conjunto, es también 

la más pesada y supone más de un 50% del peso total. 

•  Horquilla: es el elemento que transmite el movimiento desde el manillar 

hasta la rueda delantera. Básicamente existen dos tipos: horquilla rígida, 

formada por un solo bloque de material; horquilla de suspensión: como su 
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nombre indica, sirve para amortiguar los impactos del terreno en la 

bicicleta y el ciclista. 

• Asiento: formado por la tija y el sillín.  

• Ruedas: formadas por cinco elementos principales: radios, buje, cubierta, 

llanta y cámara. 

• Frenos: existen de varios tipos, principalmente los de pinza o V-Brake y 

los de disco. 

Estos elementos son los que cualquier tipo de bicicleta incluye. Obviamente, 

dependiendo del objetivo con el que se ha diseñado cada bicicleta, estos 

componentes tendrán unas características u otras, variando así su material de 

fabricación, forma, dimensiones, peso, precio, etc. 

 

1.3. Sistema de accionamiento de la bicicleta 

El sistema de accionamiento de una bicicleta se basa en el tradicional sistema de 

plato-cadena-piñón. Para accionarlo, el ciclista debe ejercer una fuerza sobre el 

pedal en la dirección del movimiento, haciendo girar el plato en sentido horario si 

se toma un sistema de coordenadas cartesianas y suponiendo que el desplazamiento 

de la bicicleta va en la dirección del eje X positivo. 

El estudio de este componente del conjunto será el objetivo principal de este 

proyecto. 

 

ILUSTRACIÓN 5: 'SISTEMA PLATO-CADENA-PIÑÓN' 
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Los cálculos sobre este componente pueden ser muy complejos y de muchos 

tipos, pero este proyecto se va a basar en el siguiente principio básico: 

𝑉𝑒𝑙𝑜𝑐𝑖𝑑𝑎𝑑 𝑙𝑖𝑛𝑒𝑎𝑙 𝑑𝑒 𝑙𝑎 𝑐𝑎𝑑𝑒𝑛𝑎 = 𝜔𝑝𝑖ñó𝑛 · 𝑟𝑝𝑖ñó𝑛 = 𝜔𝑝𝑙𝑎𝑡𝑜 · 𝑟𝑝𝑙𝑎𝑡𝑜 

ECUACIÓN 1: 'CONSERVACIÓN DE LA VELOCIDAD LINEAL EN LA CADENA' 

 

Este principio determina que la velocidad lineal de cualquier punto de la cadena 

se mantiene a lo largo de todo el recorrido, pero no ocurre así con las velocidades 

angulares del plato y el piñón. Es precisamente esta última aclaración la que hace 

que la bicicleta adquiera más velocidad lineal o menos en función del desarrollo 

utilizado, y ese será el objetivo del proyecto. 

 

1.4. Objetivos y motivación del proyecto 

Para fabricar una bicicleta, deben tenerse en cuenta muchos factores para 

adaptarla al terreno y las condiciones en que va a ser utilizada y optimizarla para 

conseguir el mejor rendimiento posible. Como todo en la industria, el nivel de 

adaptación y optimización dependerá del coste del producto y a medida que éste 

suba, también lo hará la calidad de la bicicleta. 

Con este trabajo final de grado se pretende realizar un estudio sobre una bicicleta 

convencional, y más concretamente, sobre su sistema de plato-cadena-piñón y los 

distintos desarrollos disponibles en la misma. Para ello se van a seguir unos 

sucesivos pasos que se detallarán a lo largo del proyecto. 

Los elementos que se utilizarán para componer la bicicleta serán básicos, para así 

no desviarse del objetivo principal. La bicicleta no dispondrá de suspensión, y las 

dimensiones y pesos se establecerán en base a lo estándar en este tipo de bicicletas. 

Personalmente, la elección de este proyecto se basa en el interés por aprender y 

visualizar algo tan cotidiano en nuestras vidas que en un principio parece complejo 

de entender para nosotros. En ocasiones es difícil visualizar la teoría si no se 

demuestra con ejemplos prácticos reales, y por ese motivo he decidido realizar este 

proyecto, ya que es algo muy práctico y útil para entender el funcionamiento de una 

bicicleta. 
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2. ESTUDIO DE ALTERNATIVAS Y ELECCIÓN DEL MODELO 

Desde hace unos años, internet se ha convertido en una de las principales fuentes 

de información mundial. Gracias a la inmensa cantidad de usuarios que navegan 

cada día en la red, existe una infinidad de recursos disponibles para todo el mundo. 

En muchas ocasiones, la información que se puede encontrar es de dudosa 

procedencia y no se puede confiar en ella. Sin embargo, existen muchísimas fuentes 

oficiales fiables y que se deben tener muy en cuenta. 

Para el proyecto que se está desarrollando, es necesario obtener un modelo en 

CAD (Computer Assisted Design) asimilable por el software que se va a utilizar para 

la simulación, que en este caso es MSC Adams View. Para ello, existen múltiples 

librerías en la red con excelentes modelos que se podrán utilizar de forma libre. 

Una vez obtenido el modelo adecuado, se debe ajustar el mismo a la simulación 

que se desea realizar, creando las restricciones necesarias e imponiendo las 

condiciones de contorno que sean pertinentes. 

  

2.1. Búsqueda del modelo ideal y análisis de alternativas 

De las múltiples librerías existentes en la red, la elegida para este proyecto ha 

sido la librería de GrabCAD, una comunidad online de libre acceso en la que los 

usuarios colaboran entre ellos y comparten sus recursos de forma altruista y 

desinteresada. En ella existen una infinidad de modelos realizados en CAD en 

diferentes formatos, los cuales pueden ser utilizados en softwares especializados. 

Cualquier usuario puede colaborar en esta comunidad, por lo que existen desde 

modelos muy básicos con simples formas geométricas hasta modelos excepcionales 

con todo tipo de detalles. 

Para este proyecto, se necesita un modelo básico que no sea demasiado pesado, 

ya que el entorno de Adams no está creado para utilizarse como software de diseño 

gráfico y modelado 3D, por lo que si se incluye un modelo demasiado complejo 

puede resultar muy laborioso realizar cualquier tarea. Por eso, la búsqueda del 

modelo se debe basar en la simplicidad, intentando que se asemeje a una bicicleta 

real pero sin detalles innecesarios para este proyecto. 
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ILUSTRACIÓN 6: 'LIBRERÍA GRABCAD' 

 

Para encontrar recursos, basta con hacer una simple búsqueda en la librería. 

Buscando el término Bicycle, comienzan a aparecer modelos y componentes de todo 

tipo: cadenas, platos, piñones, horquillas, manillares, cuadros, bicicletas completas, 

etc. 

Tras una búsqueda exhaustiva, se establece una lista de nueve modelos 

candidatos para la simulación y se estudia cada uno detalladamente como se 

detallará a continuación: 

En primer lugar, se encuentran dos modelos muy básicos. En un principio 

parecían buenos candidatos, pero tras analizarlos se decide descartarlos debido a la 

falta de algunos de los componentes clave y el poco detalle de otros. 

 

ILUSTRACIÓN 7: ‘CANDIDATO 1' 

 

ILUSTRACIÓN 8: ‘CANDIDATO 2' 
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En segundo lugar, se encuentra un modelo de bicicleta de carretera muy bien 

modelado. En principio parece el candidato ideal, pero su autor lo modeló en un solo 

archivo y con componentes muy detallados, por lo que tras intentar importarlo en 

Adams y comprobar que resulta muy pesado, se decide descartarlo también, y lo 

mismo ocurre con los dos siguientes modelos de montaña. 

 

ILUSTRACIÓN 9: ‘CANDIDATO 4' 

 

ILUSTRACIÓN 10: 'CANDIDATO 5' 

 

ILUSTRACIÓN 11: 'CANDIDATO 6' 
 

ILUSTRACIÓN 12: 'CANDIDATO 7' 

Después se encuentran otros dos modelos de bicicleta de montaña más básicos, 

pero su formato no es admisible por Adams y requeriría de un software externo, por 

lo que se descartan también. 

 

ILUSTRACIÓN 13: 'CANDIDATO 8' 

 

ILUSTRACIÓN 14: 'CANDIDATO 9' 
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2.2. Elección final del modelo 

Finalmente, tras realizar una búsqueda exhaustiva, se ha optado por un modelo 

de bicicleta sin suspensión, ya que el objetivo del proyecto es estudiar el sistema de 

transmisión de velocidades y no es necesario incluir suspensiones para dicho 

objetivo. Tampoco incluye cables, pinzas o discos de freno, para que el modelo sea 

lo más simétrico posible y evitar problemas de equilibrio a la hora de realizar la 

simulación. 

 

ILUSTRACIÓN 15: 'MODELO DE BICICLETA ESCOGIDO' 

 

Puede observarse que el modelo es una versión muy básica de bicicleta, pero es 

suficiente y óptimo para el desarrollo del proyecto, ya que al constar de pocos 

componentes el peso del archivo será mucho menor, por lo que será más fácil 

procesarlo, simularlo y analizarlo y se evitarán problemas de “cuelgues” del 

programa. Cabe destacar que algunos de los componentes del modelo serán 

modificados o no serán utilizados, como los platos y piñones, ya que MSC Adams 

cuenta con el módulo Machinery, ideado para modelar este tipo de sistemas de 

transmisión, como se explicará más adelante. 
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3. MODELADO DEL SISTEMA EN MSC ADAMS 

Tras haber encontrado el modelo ideal para este proyecto, se procede a su 

introducción en el software de desarrollo del mismo. El proceso consta de varios 

pasos y supone la parte más laboriosa y compleja del proyecto, por lo que se realizará 

una explicación pormenorizada en los apéndices siguientes. 

 

3.1. Despiece del modelo 

En la librería de GrabCAD, el modelo se encuentra dividido en varios archivos en 

formato ProE (.prt), incluyendo cada uno una pieza, por lo que es muy sencillo 

seleccionar qué piezas se utilizarán para la simulación. A pesar de que el formato 

recomendado para utilizar en MSC Adams es el Parasolid (.x_t), el formato ProE 

también es admisible y se genera de forma correcta, por lo que se utilizará ese a 

pesar de que aparentemente no es el más óptimo. 

Como ya se ha comentado previamente, algunos de los componentes que vienen 

en el modelo escogido no serán utilizados, por lo que se han obviado en el detalle. 

Los componentes elegidos para realizar la simulación en MSC Adams son los que se 

detallan a continuación: 

Pieza Descripción 

Cuadro Componente principal del conjunto. Se encarga de ensamblar el 
resto de partes de la bicicleta y de distribuir el peso del ciclista. 

Manillar y horquilla 
Forman una sola pieza, y se encargan de unir el movimiento de 

los brazos del ciclista con la rueda delantera para darle el 
movimiento directriz. 

Sillín Su función es únicamente servir de punto de apoyo del tronco 
del ciclista. 

Pedales Se encargan de transmitir el movimiento de los pies del ciclista 
al plato e, indirectamente, a la rueda motriz. 

Ruedas delantera y 
trasera 

Ambas son del mismo tamaño y materiales. La rueda delantera 
es la directriz y la trasera es la que, ensamblada al piñón, actúa 

como rueda motriz. 

TABLA 1:  'COMPONENTES DEL MODELO' 
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Los materiales utilizados serán básicamente dos: aluminio y caucho. El cuadro, el 

conjunto manillar y horquilla, los pedales y las llantas serán de aluminio. 

Obviamente, en una bicicleta real hay más materiales, como el caucho de las 

manetas del manillar, la goma protectora de los cables de freno y cambio de 

velocidad, el acero de dichos cables y algunos más, pero como esto se escapa del 

objetivo del proyecto, se va a simplificar todo en un único material, ya que además, 

esos componentes minoritarios no suponen una gran masa sobre el total del 

conjunto y no influyen de forma tan acusada. A continuación se presentan unas 

imágenes de las piezas ya importadas en MSC Adams, proceso que se explicará a 

continuación.  

 

ILUSTRACIÓN 16: 'DESPIECE CUADRO' 

 
ILUSTRACIÓN 17: 'DESPIECE MANILLAR Y 

HORQUILLA' 

 

ILUSTRACIÓN 18: 'DESPIECE SILLÍN' 

 

ILUSTRACIÓN 19: 'DESPIECE PEDALES ' 

 

ILUSTRACIÓN 20: 'DESPIECE RUEDA DELANTERA Y TRASERA' 
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Obsérvese que, como ya se ha comentado, algunas de las piezas deberán ser 

modificadas para simplificar el modelo. 

Principalmente, se realizarán dos modificaciones: 

1. Se eliminará el plato previamente modelado en el conjunto de los pedales, 

ya que se utilizará el módulo Machinery de MSC Adams para tal fin. 

2. Se separarán llantas y neumáticos para poder asignar el material 

correspondiente a cada uno, siendo las llantas de aluminio y los 

neumáticos de caucho. Esto es así porque si no se hiciera esa distinción, 

el peso final del conjunto se alejaría bastante de la realidad. 

 

3.2. Modelado de la bicicleta 

En este apartado del proyecto se explicará pormenorizadamente cómo realizar la 

importación de las piezas obtenidas en GrabCAD en el entorno de simulación. 

Después de ello, se deberán agrupar en distintos sólidos con el objetivo de facilitar 

el ensamblaje y evitar problemas durante la simulación. Una vez hecha la separación, 

se añadirán elementos en los puntos clave de las piezas para facilitar la identificación 

de dichos puntos y el movimiento de ellas en el plano de trabajo, y se añadirán las 

restricciones necesarias entre las piezas, creando los pares adecuados para el 

correcto funcionamiento del conjunto. También se asignarán los materiales de cada 

pieza y se orientará el sistema de la forma más conveniente para el análisis. 

 
3.2.1. Obtención del factor de escala 

El primer paso para generar el modelo de simulación es importar los archivos 

descargados en GrabCAD. En este caso, los archivos se encuentran en formato ProE 

(extensiones .asm y .prt), formato ampliamente utilizado en el diseño asistido por 

ordenador (CAD). Para generar dichos archivos, su autor ha utilizado el software 

PTC Creo Parametric. 

Antes de nada, hay que destacar que este modelo ha sido realizado a escala por 

su autor, por lo que para importarlo correctamente se deberá multiplicar cada pieza 

por el factor proporcional correspondiente, para que las dimensiones finales sean 

reales y los análisis no se vean alterados proporcionando resultados incorrectos. 
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Para averiguar este factor, hay que importar alguno de los elementos del conjunto y 

calcular sus dimensiones en el plano. Obtenidas esas dimensiones, se compararán 

con las dimensiones reales que debería tener y se calcula el factor de ampliación o 

reducción necesario. 

La pieza que se utilizará para calcular el factor será la rueda, y se utilizará como 

dimensión de referencia el diámetro externo de ella. Se considerará que la rueda a 

tamaño real tendría un diámetro externo de 26 pulgadas, es decir, 660,40 mm. 

El primer paso es importar la rueda al entorno de MSC Adams. Para ello, se crea 

un nuevo modelo en la ruta de trabajo, que deberá ser la misma en la que se ubican 

los archivos CAD y no deberá tener espacios ni caracteres especiales para evitar 

problemas. Una vez creado el modelo, se importa el archivo a través del menú File > 

Import…, seleccionando el tipo de archivo adecuado y asignándole un nombre (esto 

no es importante, ya que el archivo es temporal y no se utilizará más adelante). 

 

ILUSTRACIÓN 21: 'IMPORTACIÓN DE ARCHIVO CAD EN MSC ADAMS' 

 

ILUSTRACIÓN 22: 'RUEDA IMPORTADA EN MSC ADAMS' 
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Tras tener el archivo en Adams, lo siguiente es añadir Markers de referencia sobre 

el objeto para poder obtener el diámetro externo de la rueda. Para ello se hace click 

en Bodies > Construction > Marker, y marcando la opción Add to Part se crea el 

Marker en el punto que se crea conveniente. 

 

ILUSTRACIÓN 23: 'MARKERS CREADOS EN LOS EXTREMOS DE LA RUEDA' 

 

Con las coordenadas de los Markers creados, puede obtenerse el diámetro de la 

rueda: 

Marker Coordenada X 

MARKER_1 -294,7840674628 mm 

MARKER_2 294,7840674628 mm 

Distancia entre Markers 589,568134926 mm 

TABLA 2: 'POSICIÓN Y DISTANCIA ENTRE MARKERS DE LA RUEDA AUXILIAR' 

 

Por lo tanto, el diámetro exterior de la rueda del modelo es de 589,57 mm. Como 

el diámetro real es de 660,40 mm, el factor de escala de las piezas es: 

𝐹𝑎𝑐𝑡𝑜𝑟 𝑑𝑒 𝑒𝑠𝑐𝑎𝑙𝑎 =  
660,40

589,57
= 1,12 

ECUACIÓN 2: 'CÁLCULO DEL FACTOR DE ESCALA' 
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Es decir, para obtener medidas reales en el modelo de MSC Adams, habrá que 

multiplicar por 1,12 las piezas importadas para que su tamaño aumente hasta las 

dimensiones reales. Esto se hace en el momento de la importación, incluyendo ese 

valor en el campo Scale. Es importante decir que este valor se habría podido hallar 

de forma más sencilla en otro software, como SolidWorks o AutoCAD, pero como el 

programa principal de este proyecto es MSC Adams, se ha preferido utilizar los 

recursos disponibles en él para conseguir el factor de escala. 

 
3.2.2. Importación de las piezas en MSC Adams 

Una vez obtenido el factor de ampliación de la pieza para que las dimensiones en 

Adams sean las correctas, el siguiente paso es importar las piezas al entorno del 

programa. Para ello, los pasos a seguir se detallarán a continuación: 

Se crea la base de datos de trabajo en la misma ruta donde se ubican los archivos 

CAD, y se modifica la mesa de trabajo para darle las dimensiones adecuadas, aunque 

esto puede hacerse en cualquier momento del proyecto. Después, se importan las 

piezas mediante el menú File > Import…, de la misma manera que en el apartado 

anterior. En este caso, el modelo permite hacer la importación de dos maneras: 

importando todo el conjunto de una sola vez y eliminando las partes que no se 

necesitan, o importando solamente las piezas necesarias una por una, ya que el autor 

ha proporcionado el modelo de las dos maneras.  

Tras analizar las posibilidades, se decide importar el modelo completo para evitar 

problemas con la orientación y localización de cada pieza para así asegurar que todo 

concuerda y está bien situado en el plano. Es importante incluir en este paso el 

factor de escala calculado previamente y desmarcar la casilla Consolidate To Shells, 

para que los sólidos se importen de forma separada. La extensión del modelo 

completo es .asm, pero es el mismo formato que el de extensión .prt de los apartados 

anteriores, por lo que para realizar la importación se actúa de la misma manera. 

También se puede modificar en este paso la localización y orientación del modelo, 

pero no es necesario en este caso. 
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ILUSTRACIÓN 24: 'IMPORTACIÓN DEL MODELO CON EL FACTOR DE ESCALA' 

 

Como el modelo habrá importado todos los sólidos en un mismo Body, 

denominado en este caso como PART_2, es necesario separarlos para poder 

establecer los pares y restricciones entre ellos, por lo que deberá copiarse el 

conjunto PART_2 inicial tantas veces como sea necesario, y se eliminarán los sólidos 

que no pertenezcan a cada uno de ellos, para que cada pieza del modelo quede 

correctamente diferenciada. También se puede comprobar que el factor de escala 

es correcto y que las dimensiones del modelo son las que se buscaban. 

 

ILUSTRACIÓN 25: 'MODELO IMPORTADO CON TODOS LOS SÓLIDOS AGRUPADOS' 
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Para copiar el Body inicial, se hace click con el botón derecho y se selecciona 

Copy, y para renombrar cada parte se selecciona Rename. También se deben 

eliminar los sólidos innecesarios en cada una de las nuevas PART copiadas haciendo 

click y seleccionando Delete. Tras esto, el árbol de elementos queda de la siguiente 

manera: 

 

ILUSTRACIÓN 26: 'ÁRBOL DE ELEMENTOS TRAS LA MODIFICACIÓN' 

 

Esta modificación no afecta a la visualización del modelo, ya que aparentemente 

sigue teniendo el mismo aspecto que al inicio de la importación, pero este último 

paso era necesario para poder crear los pares cinemáticos entre los sólidos. 

 
3.2.3. Asignación de materiales a cada elemento 

El siguiente paso es asignar los materiales de cada componente. En este caso, las 

piezas son de aluminio, caucho o acero, por lo que para asignar el material se hace 

click con el botón derecho en el Body correspondiente y se asigna el material en 

Modify > Define Mass By > Geometry and Material Type > Material Type > Material > 

Guesses y se selecciona el material deseado en cada componente. Si no se dispone 
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del material o se desea introducir la densidad manualmente, se hace seleccionando 

la opción Define Mass By > Geometry and Density e introduciendo el valor de 

densidad requerido.  

En el caso del sillín y las ruedas delantera y trasera, el material a asignar es 

caucho, pero como este material no aparece en la librería de materiales de MSC 

Adams, se puede asignar una densidad al elemento de forma manual, que en este 

caso será de 934 kg/m3 a 20 ºC tal y como se indica en la bibliografía. 

El conjunto de los pedales y el eje de pedalier es de acero, por lo que se selecciona 

el material steel.  

Por último, para el cuadro y la horquilla, el material a asignar es aluminio, 

denominado en Adams como aluminum. El problema de estas piezas es que en un 

modelo real son piezas huecas, pero en este caso, el autor las ha modelado como 

piezas macizas, por lo que si se asigna como material el aluminio directamente y se 

deja que Adams calcule su masa, dará un valor muy superior al real. En concreto, da 

un valor de 4,519 kg para la horquilla y 11,936 kg para el cuadro, lo que hace que el 

conjunto total de la bicicleta pese 24,415 kg, algo totalmente irreal, ya que una 

bicicleta de aluminio de talla XL de materiales estándar suele rondar un peso de unos 

14,5 kg. Por lo tanto, para asignar el material a estas dos piezas, se calcula su 

densidad a partir de la masa y el volumen. Teniendo en cuenta el volumen de cada 

una de las dos piezas, se observa que suman un total de 6,005 · 10-3 m3, suponiendo 

el cuadro un 72,54% y la horquilla un 27,46% (el volumen puede verse en la ventana 

Info de cada elemento). Si además se supone una masa total de 14,5 kg y se suma la 

masa del resto de componentes (obteniendo un valor de 7,96 kg), se puede calcular 

la masa restante, que será de 6,54 kg. Teniendo en cuenta esa masa restante y los 

porcentajes de volumen de la horquilla y el cuadro, y sabiendo que son del mismo 

material, se calcula su densidad: 

𝑀𝑎𝑠𝑎 𝑐𝑢𝑎𝑑𝑟𝑜 =
72,54

100
· 6,54 𝑘𝑔 = 4,74 𝑘𝑔 → 𝐷𝑒𝑛𝑠. =

4,74 𝑘𝑔

4,356 · 10−3 𝑚3
= 1088

𝑘𝑔

𝑚3
 

𝑀𝑎𝑠𝑎 ℎ𝑜𝑟𝑞𝑢𝑖𝑙𝑙𝑎 =
27,46

100
· 6,54 𝑘𝑔 = 1,80 𝑘𝑔 → 𝐷𝑒𝑛𝑠. =

1,80 𝑘𝑔

1,649 · 10−3 𝑚3
= 1091

𝑘𝑔

𝑚3
 

ECUACIÓN 3: 'CÁLCULO DE LA DENSIDAD DEL CUADRO Y LA HORQUILLA' 
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Como era de esperar, puede considerarse que ambas densidades son iguales. Este 

es el valor que se debe introducir en Adams para que se calcule la masa 

automáticamente. Tras introducirlo, puede comprobarse en la ventana Info que la 

masa calculada es correcta. En una bicicleta real, la densidad del material sería 

incorrecta, pero como en este proyecto no se van a analizar los componentes a 

rotura ni deformación, se puede prescindir de las propiedades internas del material. 

Tras asignar los materiales y densidades a cada elemento, las masas quedan de la 

siguiente manera: 

Componente Densidad (kg/m3) Masa (kg) 

Rueda_Trasera 950 kg/m3 1,817 

Rueda_Delantera 950 kg/m3 1,807 

Sillin 950 kg/m3 1,582 

Pedales 7801 kg/m3 2,754 

Horquilla 1090 kg/m3 1,798 

Cuadro 1090 kg/m3 4,748 

Masa_Total - 14,506 kg 

TABLA 3: 'MATERIAL Y MASA DE CADA COMPONENTE' 

 

Es importante verificar también que la gravedad del entorno es correcta, y para 

ello hay que ir al menú Settings > Gravity y verificar que la gravedad en la dirección 

vertical y hacia abajo es de 9,81 m/s2, o de 9806,65 mm/s2 como en este caso. 

 

ILUSTRACIÓN 27: 'ASIGNACIÓN DEL MATERIAL A CADA PIEZA ' 
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3.2.4. Ajuste geométrico de los elementos 
Como ya se ha comentado, hay elementos del modelo que deben ser modificados 

para adaptarlos al caso de estudio. En este caso, es necesario eliminar los platos que 

vienen incluidos en el modelado de los pedales, ya que no serán utilizados de esta 

manera, sino que se utilizará el módulo Machinery. Para ello, hay que crear un sólido 

nuevo incluido en la entidad Pedales, haciendo click en Bodies > Cylinder. 

Seleccionando los diámetros adecuados y ejecutando los Booleans y Features 

correspondientes, se consigue eliminar ese elemento innecesario. 

Este proceso es algo laborioso, pero con un poco de lógica es sencillo de realizar. 

Básicamente hay que modelar un cilindro de diámetro mayor que el plato más 

grande del modelo y aplicar la acción Features > Add a hole, con el objetivo de crear 

un cilindro con un hueco de diámetro igual al del eje de pedalier. Obtenida esta 

forma, se sitúa sobre los pedales y aplicando el Boolean: Cut out a solid with another 

se consigue eliminar el conjunto de platos. 

Tras todo el proceso, el elemento queda como se muestra en las siguientes 

ilustraciones: 

 

ILUSTRACIÓN 28: ‘EN ROJO, CILINDRO HUECO AUXILIAR’ 
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ILUSTRACIÓN 29: 'NUEVA GEOMETRÍA DE LOS PEDALES TRAS EL CORTE' 

 

Con esto se consigue que la nueva geometría esté preparada para montar el 

sistema de transmisión sobre ella. 

 

3.3. Creación de restricciones y pares cinemáticos 

Tras haber realizado correctamente los pasos anteriores, la geometría del modelo 

queda totalmente definida. Después de esto, hay que establecer una serie de 

restricciones y pares cinemáticos entre todos los elementos del modelo, ya que si 

no estarían libres por el espacio y no tendrían ningún sentido en el proyecto. 

El listado de pares cinemáticos y los sólidos relacionados es el siguiente: 

Nombre del par 
Tipo de 

par Sólido 1 Sólido 2 Punto de aplicación 

R_Horq_Cuadro Revolución Cuadro Horquilla Cuadro.MARKER_24 

R_Pedal_Cuadro Revolución Cuadro Pedales Pedales.cm 

Fijo_Sillin_Cuadro Fijo Cuadro Sillin Cuadro.SOLID1.V178 

R_RDel_Horquilla Revolución Horquilla Rueda_Delantera Rueda_Delantera.cm 

R_RTras_Cuadro Revolución Cuadro Rueda_Trasera Rueda_Trasera.cm 

TABLA 4: 'PARES CINEMÁTICOS DEL MODELO' 
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Como se observa, el modelo consta de cuatro pares de revolución entre los 

componentes de la bicicleta y el cuadro, debido a que todos los componentes siguen 

un movimiento rotatorio a través de un eje y no existe un desplazamiento transversal 

a lo largo del mismo, por lo que el único par existente es el de rotación. Existe otro 

par de rotación entre la rueda delantera y la horquilla. Por último, también hay un 

par fijo entre el cuadro y el sillín, cuya única función es la de fijar e impedir el 

movimiento del mismo.  

 
3.3.1. Pares de rotación de las ruedas, pedales y sillín 

Para crear los pares cinemáticos hay que ir al apartado Connectors > Joints y 

seleccionar el par que se desee crear. En este caso, el par de revolución se crea 

clickando en Create a Revolute Joint, y el par fijo en Create a Fixed Joint. Para situar 

el par en el punto exacto del modelo en el que se desea que actúe dicho par, es 

necesario localizar ese punto con un Marker. Para ello, hay que seguir un proceso 

similar al de los apartados anteriores para crear Markers en los puntos en los que se 

va a aplicar cada par. 

Tras crear los Markers, se selecciona Create a Revolute Joint, se marca la opción 

2 Bodies – 1 Location y se hace click en uno de los cuerpos, luego en el otro y 

finalmente en el Marker donde se va a localizar el par. Si el par creado no queda en 

la orientación deseada, se puede seleccionar en el apartado del árbol de entidades, 

en la opción Connectors, y haciendo doble click y después en el segundo icono de la 

ventana que aparece, llamado Change Position, se puede rotar y trasladar el par hasta 

dejarlo en la posición deseada. 

 
3.3.2. Par de rotación entre la horquilla y el cuadro 

En este modelo en concreto, la ubicación espacial de los pares es sencilla debido 

a que casi todos los ejes en los que actúa cada uno se encuentran de forma 

perpendicular o paralela al plano de referencia, por lo que es fácil utilizar los centros 

de masas de los elementos como puntos de aplicación de los pares, a excepción del 

par de rotación entre la horquilla-manillar y el cuadro, que tiene un pequeño ángulo 

de inclinación, por lo que primero será necesario ubicar manualmente el Marker 

donde se va a aplicar el par. Como el punto de aplicación de ese par va a ser el centro 
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del tubo de dirección del cuadro, será necesario crear un Marker en dicho punto, y 

como la geometría del modelo es algo compleja, es necesario crear primero dos 

Markers auxiliares para conocer la ubicación exacta del punto central, así como su 

orientación. Para ello, se utiliza el procedimiento tradicional y se crea un Marker en 

la cara superior del cilindro y otro en la cara inferior: 

 

ILUSTRACIÓN 30: 'MARKERS AUXILIARES EN EL CUADRO' 

 

Una vez creados esos puntos auxiliares, se buscan sus coordenadas exactas 

haciendo click sobre cada uno con el botón derecho y en el apartado Info se pueden 

ver sus coordenadas, siendo estas las que siguen: 

Marker Coordenada X (mm) Coordenada Y (mm) Coordenada Z (mm) 

Cuadro.MARKER_22 -495,6461078973 527,6553563619 40,88 

Cuadro.MARKER_23 -538,3147096335 394,3159757353 40,88 

TABLA 5: 'COORDENADAS DE LOS MARKERS AUXILIARES' 

 

Para hallar las coordenadas del punto central, basta con calcular el punto medio 

entre los dos de la tabla superior: 

𝑋 = −495,6461078973 −
538,3147096335 − 495,6461078973

2
= −516,9804087654 

𝑌 = 394,3159757353 +
527,6553563619 − 394,3159757353

2
= 460,9856660486 

𝑍 = 40,88 

ECUACIÓN 4: 'COORDENADAS DEL MARKER CENTRAL DE LA DIRECCIÓN' 
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Por otro lado, para calcular la orientación del Marker central es necesario hacer 

un pequeño cálculo trigonométrico: 

 

ILUSTRACIÓN 31: 'TRIGONOMETRÍA AUXILIAR' 

 

Á𝑛𝑔𝑢𝑙𝑜 = 𝑎𝑟𝑐𝑡𝑔 (
133,3393806266

42,6686017362
) = 72,2553284º 

ECUACIÓN 5: 'ÁNGULO DE ORIENTACIÓN DEL MARKER CENTRAL DE LA DIRECCIÓN' 

 

Con las coordenadas cartesianas y el ángulo de inclinación, ya se puede situar el 

Marker en el plano: 

 

ILUSTRACIÓN 32: 'COORDENADAS Y ORIENTACIÓN DEL MARKER CENTRAL EN EL MODELO' 
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Cabe destacar que el ángulo de orientación del eje X es el complementario al 

calculado en el paso anterior, es decir: 

Á𝑛𝑔𝑢𝑙𝑜 𝑐𝑜𝑚𝑝𝑙𝑒𝑚𝑒𝑛𝑡𝑎𝑟𝑖𝑜 = 90º − 72,2553284º = 17,7446716º 

Además, para que la inclinación sea en el sentido correcto se le añade un signo 

negativo, o lo que es lo mismo, se resta a 360º y da un ángulo de 342,2553284º. 

Una vez creado el Marker y ubicado en su lugar correcto, ya se puede crear el par 

de rotación correspondiente entre la horquilla y el cuadro. Para ello se procede de 

la misma forma que para crear los pares anteriores de rotación anteriores. 

 
3.3.3. Resumen de pares cinemáticos 

Con todos los pares ya creados la, geometría de la bicicleta queda completamente 

definida, quedando todos sus elementos relacionados y con las restricciones y 

movimientos adecuados entre ellos. Tras esto, ya se pueden empezar a definir las 

condiciones de contorno del sistema.  

El nuevo árbol de entidades con todos los pares creados queda como se muestra 

en la siguiente ilustración. Para visualizarlos mejor en el modelo, se ha aumentado 

su tamaño en el menú Settings > Icons > New Size. 

 

ILUSTRACIÓN 33: 'VISUALIZACIÓN DE LOS PARES CINEMÁTICOS EN EL MODELO' 
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3.4. Condiciones de contorno del modelo 

Tras haber definido completamente la geometría de la bicicleta a excepción del 

sistema de transmisión de movimiento, se procede a crear las condiciones de 

contorno del modelo para realizar la simulación. 

 
3.4.1. Terreno de apoyo 

Lo primero que hay que definir para poder realizar la simulación es el terreno 

donde se va a apoyar y desplazar la bicicleta. Este terreno se irá variando a medida 

que se vayan realizando los sucesivos estudios, pero en este apartado se explicará 

cómo crear una primera versión del suelo. 

En primer lugar, se selecciona el sólido correspondiente en el apartado del menú 

Bodies > Solids > RigidBody: Box. Al seleccionarlo, en el menú de la izquierda se 

establecen las dimensiones y condiciones en que se va a crear dicho sólido. Se 

selecciona New Part y se establecen unas medidas fijas. En este caso, las 

dimensiones iniciales podrían ser las siguientes: 

 

ILUSTRACIÓN 34: 'DIMENSIONES INICIALES DEL TERRENO' 

 

Se establece una anchura de 1 metro para que la bicicleta tenga margen al 

desplazarse transversalmente, y una longitud inicial de 20 metros para que sea 

suficiente para el desplazamiento de la bicicleta y tener una buena cantidad de datos 

disponibles para analizar. Para la altura se establecen 20 centímetros, aunque no es 

un valor relevante. 

Tras crear el sólido, el sistema queda como se muestra en la siguiente ilustración 

desde una vista cenital: 
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ILUSTRACIÓN 35: 'POSICIÓN INICIAL DEL TERRENO Y LA BICICLETA' 

 

Puede observarse claramente que el sistema está desplazado, por lo que es 

necesario ubicarlo en su lugar correcto. Lo más sencillo es situar los cuerpos 

centrados en los ejes de coordenadas globales del sistema. Para ello, se seleccionan 

las entidades que se desean mover y se hace click en el menú Edit > Move. Se 

selecciona la opción About the model y en el campo Translate se introduce el valor 

de desplazamiento necesario. En el caso del suelo, 500 mm en el eje Z negativo, y en 

el caso de la bicicleta, 77,8371068805 mm en dirección Z positiva. En esta misma 

ventana se puede cambiar también la orientación de la bicicleta para que se desplace 

en el eje X positivo, y para ello se introduce 180º en el campo Rotate y se hace click 

en el eje Y. 

Por otro lado, también se puede aprovechar para modificar las dimensiones de la 

rejilla de trabajo y adaptarlas al nuevo modelo. Esto se hace en el menú Settings > 

Working Grid e introduciendo las nuevas medidas en el campo Size, adaptándolas 

para que pueda verse el modelo completo dentro de la rejilla. 

 

ILUSTRACIÓN 36: 'VENTANA MOVE PARA DESPLAZAR ENTIDADES' 
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Tras realizar las modificaciones, el sistema queda como se muestra: 

 

ILUSTRACIÓN 37: 'NUEVA POSICIÓN Y ORIENTACIÓN DEL SISTEMA' 

 

Por último, se añade un par fijo en cualquier punto del sólido del terreno, con el 

objetivo de fijarlo al entorno de trabajo. Este par se renombrará como 

Fijo_SUELO_Ground con el método ya explicado en apartados anteriores. 

Para crear el suelo con inclinación del 12%, se procede de manera similar. Primero 

se crea un tramo horizontal de 3 metros, y a continuación un sólido de 20 metros 

que se creará con la opción Add to Part marcada al crearlo, para así añadirlo en el 

mismo tramo que el horizontal. Tras esto, se selecciona su Marker de referencia y 

se rota 6.84º, obteniendo finalmente el siguiente resultado: 

 

ILUSTRACIÓN 38: TERRENO CON INCLINACIÓN DEL 12%' 
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3.4.2. Contacto entre las ruedas y el terreno 
Tras haber creado el terreno de apoyo y desplazamiento, es necesario establecer 

un contacto entre las ruedas de la bicicleta y el mismo, ya que si no la bicicleta 

atravesaría el suelo. 

Para establecer ese contacto necesario, se hace click en el menú Forces > Special 

Forces > Create a Contact. En la ventana emergente se incluyen los sólidos que harán 

contacto como en la tabla que sigue: 

Contacto Sólido I Sólido J 

Contacto_RDel Rueda_Delantera.SOLID4 SUELO.BOX_39 

Contacto_RTras Rueda_Trasera.SOLID5 SUELO.BOX_39 

TABLA 6: 'CONTACTOS ENTRE LAS RUEDAS Y EL SUELO' 

 

Es importante que el Contact Type sea del tipo Solid to Solid. Además, también 

hay que añadir fricción con el suelo, y para ello se marca la opción Coulomb en el 

apartado Friction Force, dejando las opciones por defecto. 

 

ILUSTRACIÓN 39: 'CREACIÓN DE CONTACTOS DE FRICCIÓN' 
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Tras crear un contacto de fricción con el suelo tanto en la rueda trasera como la 

delantera, la bicicleta ya tiene la capacidad de apoyarse y desplazarse en el suelo sin 

atravesarlo. 

Más adelante, cuando se decida modificar el terreno, lo más sencillo es eliminar 

primero los contactos y después hacer las modificaciones necesarias, ya que la 

creación de los mismos es muy sencilla y si se cambia la orientación del suelo puede 

haber problemas con los Markers de referencia que serán algo laboriosos de 

resolver. 

 
3.4.3. Prueba del modelo 

Tras haber realizado todos estos pasos, se puede hacer una pequeña prueba con 

el modelo para ver si todo está correctamente modelado y no hay enfrentamientos 

entre entidades. Para ello, se puede aplicar una rotación en el par de la rueda trasera 

con el cuadro, como si estuviera actuando la cadena de transmisión. Para crear esta 

rotación se hace en el menú Motions > Joint Motions > Rotational Joint Motion, y se 

hace click en el par de rotación donde se desea aplicar el movimiento, en este caso, 

el par es el R_RTras_Cuadro. El movimiento aplicado aparecerá en el apartado 

Motions del árbol de entidades. Se puede modificar la velocidad de rotación 

haciendo click con el botón derecho y seleccionando Modify. 

Tras haber creado el movimiento, se puede probar el modelo en el apartado 

Simulation > Simulate > Run an Interactive Simulation. Se establece un tiempo de 2.5 

segundos y 200 pasos y se hace click en el botón Start simulation. Si todo va 

correctamente, el sistema se empezará a mover, tal y como ocurre en este caso.  
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ILUSTRACIÓN 40: 'VENTANA DE LA SIMULACIÓN' 

 

El principal problema ahora es resolver el equilibrio de la bicicleta, ya que tras 

avanzar unos metros el sistema se desequilibra y cae al suelo completamente. Esto 

es algo normal, ya que todavía no se han introducido las fuerzas que equilibrarán el 

sistema, y esto es algo que se desarrollará más adelante.  

El principal origen del problema es la ubicación y orientación de los centros de 

masas de cada elemento de la bicicleta. Al haberse modelado por separado, cada 

elemento tiene su propio centro de masas, y como estos no están exactamente en 

el mismo plano X-Y existen momentos desequilibrantes al haber pequeñas 

distancias entre esos centros de masas y el eje central de la bicicleta. Si fuera 

necesario, las fuerzas para equilibrar el sistema se añadirán más adelante, ya que 

todavía no se ha generado el sistema de transmisión y este añadirá más masa al 

conjunto, por lo que es recomendable no introducir ninguna fuerza hasta probar el 

modelo definitivo y ver si realmente son necesarias. 
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ILUSTRACIÓN 41: 'BICICLETA DESEQUILIBRADA' 

 

3.4.4. Adición del peso del ciclista 
La última condición de contorno necesaria es el propio peso del ciclista. En este 

caso, como el modelado de una persona no es importante para el proyecto, se decide 

aplicar masas puntuales en los lugares clave donde lo haría un ciclista en la vida real. 

Según un estudio biomecánico realizado por el instituto Ergocycling Iberica, el 

sillín de la bicicleta soporta el 60% del peso total del ciclista y el manillar el 40%. Por 

lo tanto, considerando el peso medio de un hombre adulto en 75 kg, se deberán 

añadir las siguientes masas puntuales: 

𝑀𝑎𝑠𝑎 𝑝𝑢𝑛𝑡𝑢𝑎𝑙 𝑒𝑛 𝑒𝑙 𝑠𝑖𝑙𝑙í𝑛 →
60

100
· 75 𝑘𝑔 =  45 𝑘𝑔 

𝑀𝑎𝑠𝑎 𝑝𝑢𝑛𝑡𝑢𝑎𝑙 𝑒𝑛 𝑒𝑙 𝑚𝑎𝑛𝑖𝑙𝑙𝑎𝑟 →
40

100
· 75 𝑘𝑔 = 30 𝑘𝑔 

ECUACIÓN 6: 'DISTRIBUCIÓN DEL PESO DEL CICLISTA EN EL SILLÍN Y EL MANILLAR ' 

 

Para aplicar estas masas puntuales se hace click en Bodies > Construction > 

Construction Geometry: Mass, y se incluye la masa a aplicar y el punto de aplicación. 

En este caso, los puntos de aplicación son el centro de masas del sillín y el 

MARKER_26 de la horquilla. Creadas estas dos masas puntuales, el árbol de 

entidades queda de la siguiente manera: 
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ILUSTRACIÓN 42: 'MASAS PUNTUALES EN EL ÁRBOL DE ENTIDADES' 

 

En cuanto a las características de ambas masas, quedarían de la siguiente manera: 

Masa puntual 
Porcentaje de 
masa total del 

ciclista 
Masa Marker de aplicación 

Masa_Ciclista_Manillar_40 40% 30 kg Horquilla.MARKER_26 

Masa_Ciclista_Sillin_60 60% 45 kg Sillin.cm 

TABLA 7: 'CARACTERÍSTICAS DE LAS MASAS PUNTUALES ' 
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4. CREACIÓN DEL SISTEMA DE TRANSMISIÓN DE 
MOVIMIENTO 

Una vez generado el modelo de la bicicleta y establecido el contacto con el suelo, 

ya se puede proceder a crear el sistema de transmisión de movimiento de la 

bicicleta, objeto principal de estudio de este proyecto. Para comenzar con el 

desarrollo del sistema de plato-piñón-cadena, es necesario preparar el modelo 

primero.  

 

4.1. Preparación previa de la bicicleta 

Lo primero es eliminar el movimiento de rotación añadido en el apartado anterior 

para hacer una primera prueba del modelo, y esto se hace en el árbol de entidades, 

buscando el Motion correspondiente y eliminándolo haciendo click con el botón 

derecho y luego en Delete. Eliminado este movimiento, la bicicleta vuelve a estar 

completamente estática, a excepción del desequilibrio comentado anteriormente 

que la hará caer a los pocos segundos, tal y como ocurriría en una bicicleta real. 

Tras eliminar el movimiento, se deben añadir unos Markers en los puntos donde 

se colocarán el plato y el piñón. Es importante que esos Markers se sitúen en el 

mismo plano X-Y para que no haya desplazamiento transversal en la cadena. 

Basándose en un modelo de bicicleta real, se puede ver fácilmente que el plato rota 

de forma solidaria a los pedales, y el piñón lo hace junto a la rueda trasera. Por lo 

tanto, será necesario añadir un Marker en los Pedales y otro en la Rueda_Trasera 

para utilizarlos de punto de referencia para añadir la transmisión. Ambos deben 

compartir la misma coordenada global en Z, ya que así sus puntos de apoyo se 

situarán en el mismo plano X-Y. También es importante que ambos se ubiquen 

exactamente sobre el eje de rotación del cuerpo al que van anclados, ya que si no se 

descentrarían y habría problemas con las transmisiones de movimiento. 

Para crear los dos Markers de referencia de la transmisión, se procede de igual 

manera que en los apartados anteriores. Para que ambos tengan la misma 

coordenada Z, se puede modificar manualmente para introducir su valor exacto. 

Primero se crea el Marker ubicado en los pedales, ya que es el más sencillo de los 

dos. Se decide ubicarlo en la posición en la que se situaban originalmente los platos 
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del modelo descargado de GrabCAD, es decir, en la cara exterior de la parte derecha 

del eje de pedalier, si se mira la bicicleta desde la parte trasera en dirección 

perpendicular a los ejes de rotación de las ruedas. Se pueden ocultar los otros 

sólidos para tener una mejor visualización de los pedales: 

 

ILUSTRACIÓN 43: 'UBICACIÓN DEL MARKER_31 EN LOS PEDALES' 

 

Creado el Marker_31 situado en los pedales, se procede a crear de forma similar 

el Marker de referencia situado en la rueda trasera. Para ello es necesario añadir un 

pequeño suplemento en la rueda, ya que al haber importado el modelo original 

eliminando piezas innecesarias en un primer momento, esa pieza no está presente 

ahora. Se trata de la pieza denominada por el autor como gearfit, que traducido 

significa acople del engranaje. 

 

ILUSTRACIÓN 44: 'ACOPLE DE LOS PIÑONES CON LA RUEDA TRASERA' 
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Para importar esta pieza en el modelo, se procede exactamente de la misma 

manera que al inicio del proyecto, haciendo click en File > Import con el File Type 

seleccionado en ProE (.prt), se busca la pieza gearfit.prt.6 en la misma ruta de trabajo 

y se incluye en la Rueda_Trasera, sin olvidarse del factor Scale 1.12. Si todo ha ido 

bien, se habrá creado un nuevo SOLID46 y el Marker PSMAR32 en la Rueda_Trasera, 

correspondientes a la nueva pieza.  

 

ILUSTRACIÓN 45: 'IMPORTACIÓN DE LA PIEZA GEARFIT' 

 

Con esto, solo queda ubicar la pieza en su posición correcta. Se puede hacer de 

varias maneras, pero la más sencilla es mover el Marker PSMAR32 ayudándose de la 

ventana Modify del mismo y del menú Edit > Move, como se ha hecho anteriormente, 

pero primero es necesario conocer las coordenadas exactas donde se quiere 

colocar. Primero se rota un ángulo de -90º alrededor del eje Y global, y después, 

basándose en las coordenadas del MARKER_17 de la rueda trasera se desplaza hasta 

esa misma posición mediante la ventana Modify. Finalmente, se puede ajustar el 

Marker hasta la posición deseada utilizando de nuevo la ventana Edit > Move. 

Tras todo este laborioso proceso, las posiciones de los dos Markers de referencia 

quedan como se indica en la siguiente tabla: 

Marker Body Coordenada X Coordenada Y Coordenada Z 

Marker_31 Pedales 0,0 0,0 48,717506636 

PSMAR32 Rueda_Trasera -484,6300073216 2,1409370639 48,717506636 

TABLA 8: 'MARKERS DE REFERENCIA PARA LA TRANSMISIÓN' 
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ILUSTRACIÓN 46: 'POSICIÓN DE LOS MARKERS PSMAR32 Y MARKER_31 EN EL MODELO' 

 

Estos Markers son los puntos clave para colocar el plato y el piñón del sistema de 

transmisión. 

 

4.2. Definición de la geometría de la transmisión 

Una vez establecidos los Markers de referencia para colocar la transmisión sobre 

el sistema, es necesario definir la geometría de la propia transmisión. 

 
4.2.1. Escenarios de simulación 

El proyecto se va a desarrollar en seis escenarios distintos, para poder recopilar 

una buena cantidad de datos para someterlos a estudio, pero sin hacer más de los 

necesarios. Estos escenarios se diferenciarán, básicamente, en la pendiente del 

terreno y en el desarrollo utilizado en la transmisión. Así, se podrán comparar los 

datos para cada terreno en función del piñón utilizado en cada momento.  

Con el estudio de los distintos escenarios, se pretende relacionar la fuerza 

necesaria a ejercer en los pedales con la velocidad adquirida, para así demostrar por 

qué es mejor utilizar unos desarrollos u otros en función de la inclinación del 

terreno.  

Se utilizará el mismo tamaño de plato para todos los escenarios, ya que es así 

como trabajan la mayoría de bicicletas de montaña actuales. El plato escogido es el 
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de 34 dientes, uno de los estándar más utilizados en MTB. En cuanto a los piñones, 

se utilizarán tres tamaños diferentes: el pequeño, con 10 dientes; el intermedio, con 

24 dientes; el grande, con 50 dientes. El resto de la geometría de los elementos la 

calcula Adams automáticamente al introducir el número de dientes y el ancho del 

engranaje. Cabe destacar que esta información ha sido extraída de un modelo de 

bicicleta real, concretamente, la Orbea Alma M10 19, que a pesar de tener una 

geometría y componentes muy distintos a la bicicleta de este proyecto, es un 

referente en el mundo del ciclismo y por eso se toma como punto de partida. El plato 

de referencia es el SRAM X1 Eagle Dub Carbon Boost 34T, mientras que para los 

piñones se utiliza el SRAM GX XG-1275 Eagle 10-50T 12-Speed. 

Con estas tres combinaciones y los dos terrenos distintos, quedan definidos los 

seis escenarios. Dichos escenarios serán los siguientes: 

Escenario Dientes del plato  Dientes del piñón 
Inclinación del 

terreno 

1 34 10 0% (0º) 

2 34 24 0% (0º) 

3 34 50 0% (0º) 

4 34 10 12% (6,84º) 

5 34 24 12% (6,84º) 

6 34 50 12% (6,84º) 

TABLA 9: 'ESCENARIOS DE ESTUDIO DE LA SIMULACIÓN' 

 

4.2.2. Creación del plato y el piñón 
El proceso de creación de la transmisión en el modelo consta de varios pasos 

claramente diferenciados. 

En primer lugar, debe crearse el conjunto de plato y piñón que se desea utilizar. 

Para ello, se hace click en el módulo Machinery > Chain > Create Closed Loop 

Sprockets. Se abrirá una ventana en la que introducir el nombre del sistema de 

transmisión y del conjunto de ruedas dentadas, así como el tipo de las mismas. Se 

pueden cambiar los nombres libremente, y se selecciona Roller Sprocket, ya que esto 

crea un sistema con una cadena compuesta por rodillos cilíndricos, que es lo que se 



53 

busca en este caso. Después, se selecciona el método 2D Links, ya que el método 

Constraint está demasiado simplificado y no permite introducir el número de 

dientes, mientras que el 3D Links es demasiado complejo para lo que aquí se 

pretende. 

 

ILUSTRACIÓN 47: 'CREACIÓN DE LAS RUEDAS DENTADAS' 

 

 

ILUSTRACIÓN 48: 'MÉTODO 2D LINKS PARA LA TRANSMISIÓN' 

 

Si se continúa avanzando, aparece la ventana donde se introducirá la geometría 

del sistema. En este primer caso, se va a modelar el plato de 34 dientes junto al piñón 

de 10 dientes.  

Pueden observarse en esta ventana dos pestañas, una para cada rueda dentada. 

Se considerará que la rueda 1 es el plato y la 2 es el piñón. Para modelarlos, primero 

hay que introducir un nombre para cada uno de ellos. En este caso, el plato será 

Plato_34_10 y el piñón será Pinon_10. En cuanto a la geometría, Adams permite 
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modificar muchísimos parámetros, pero en este caso se decide introducir 

únicamente el número de dientes y el ancho de la rueda dentada, ya que a partir de 

esos dos datos el software es capaz de calcular el resto de la geometría. Por lo tanto, 

se introduce en el campo Number of Teeth un 34 para el plato, y un 10 para el piñón. 

En cuanto al ancho, Width, puede dejarse en 6 mm, ya que como no se va a estudiar 

el componente a deformación ni rotura no es un dato tan relevante. Por último, debe 

seleccionarse también el punto central de ambos elementos. Es aquí donde entran 

los Markers creados en el apéndice 4.1., siendo el Marker_31 de los pedales el punto 

central del plato y el PSMAR32 el del piñón. 

Tras introducir los datos, las ventanas quedan de la siguiente manera: 

 

ILUSTRACIÓN 49: 'GEOMETRÍA DEL PLATO' 

 

 

ILUSTRACIÓN 50: 'GEOMETRÍA DEL PIÑÓN ' 
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La siguiente ventana es para definir el material. Se deja el acero como material 

por defecto para ambos componentes, y las opciones de contacto también se dejan 

como están. 

En el siguiente paso se introducen los tipos de pares que tendrá cada rueda 

dentada, así como el sólido al que irán ancladas. En el caso del plato, será un par de 

tipo Fixed e irá anclado al sólido Pedales, mientras que el piñón también será de tipo 

Fixed y se anclará a la Rueda_Trasera. Los pares son de tipo fijo para que no haya 

rotación de los engranajes respecto a los sólidos, sino para que sea el conjunto del 

sólido con el engranaje el que rota respecto al cuadro. 

 
ILUSTRACIÓN 51: 'PAR Y UBICACIÓN DEL PLATO' 

 
ILUSTRACIÓN 52: 'PAR Y UBICACIÓN DEL PIÑÓN' 

 

Las siguientes ventanas se pueden dejar con las opciones por defecto. 

Finalmente, aparecen en el modelo el plato y el piñón recién creados. Puede 

comprobarse fácilmente si su ubicación es correcta moviendo la vista del modelo. 

 

ILUSTRACIÓN 53: 'PLATO Y PIÑÓN CREADOS EN EL MODELO' 
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Con esto queda definida la creación del plato y el piñón del primer conjunto. Tras 

esto, se procede a crear la cadena. 

 
4.2.3. Creación de la cadena 

Para crear la cadena, se hace click en el módulo Machinery > Chain > Create 

Chain. En la ventana emergente, se selecciona el conjunto creado anteriormente 

mediante el botón derecho en el recuadro y clickando en sprocket_set > Guesses > 

.TrabajoFinal_DRP.Sistema_34_10.Conjunto_34_10. 

 

ILUSTRACIÓN 54: 'CREACIÓN DE LA CADENA ' 

 

A continuación, se selecciona el método 2D Links como se ha hecho previamente 

con las ruedas dentadas, y se selecciona después en el apartado Compliance el 

método Linear, para que la cadena sea lineal. 

 

ILUSTRACIÓN 55: 'MÉTODO LINEAR PARA LA CADENA' 
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En la siguiente ventana se dejan todas las opciones por defecto, a excepción del 

nombre, que se cambiará en este caso por Cadena_34_10. 

Se avanzan unos pasos más y se llega al Wrapping Order, donde se deben 

seleccionar los engranajes en el orden correspondiente. En este caso, se selecciona 

primero el plato y después el piñón. Para ello, se hace click en el recuadro con el 

botón derecho y en UDE_Instance > Guesses se selecciona primero el plato y 

después el piñón. Al finalizar la creación, Adams lanza una advertencia e indica que 

la cadena está formada por 130 eslabones.  

Si se compara con el modelo de bicicleta mencionado anteriormente (Orbea 

Alma), se observa que esta tiene 114 eslabones. La diferencia es algo notable, pero es 

lógico, ya que la distancia entre la rueda trasera y el eje de pedalier no es la misma 

en el modelo del proyecto que en esa bicicleta, por lo que se da el valor por bueno.  

Por otro lado, en el modelo de Adams cada desarrollo tendrá un número de 

eslabones, debido a que el sistema no cuenta con el desviador de la cadena que sí 

tiene una bicicleta real y permite que una misma cadena se acople a distintos 

desarrollos. 

 

ILUSTRACIÓN 56: 'ADVERTENCIA TRAS CREAR LA CADENA' 

 

Tras aceptar la advertencia, se finaliza la creación de la cadena, y se observa cómo 

ha aparecido en el modelo correctamente engranada. Puede observarse desde las 

distintas orientaciones cómo la cadena encaja perfectamente en los dientes de las 

ruedas dentadas. 
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ILUSTRACIÓN 57: 'TRANSMISIÓN CREADA COMPLETAMENTE' 

 

Tras todos estos pasos, la creación del sistema de transmisión queda 

completamente definida.  

Los pasos para crear los otros dos desarrollos son idénticos, simplemente se debe 

cambiar el número de dientes del piñón. Para ello, lo mejor es desactivar y ocultar el 

sistema ya creado, para que así puedan convivir los tres desarrollos en el mismo 

archivo sin que haya conflicto entre unos y otros, y que se active solamente uno 

cada vez que se realice una simulación. 

Para evitar el conflicto, se hace click con el botón derecho en el Sistema_34_10 y 

luego en (De)activate, desmarcando las dos casillas que aparecen. Después, se hace 

click en Hide y se oculta el sistema. Esto hace que la transmisión quede 

completamente desactivada y no influya en el modelo. Hecho esto, se procede con 

la creación de los otros dos desarrollos siguiendo los mismos pasos. 

Tras todo el proceso, el árbol de entidades queda de la siguiente manera: 

 

ILUSTRACIÓN 58: 'DESARROLLOS CREADOS EN EL ÁRBOL DE ENTIDADES' 
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Para que el sistema se mueva, es necesario añadir una rotación en los pedales, ya 

sea ejerciendo una fuerza en cada uno o introduciendo un movimiento rotatorio en 

el par R_Pedal_Cuadro. A continuación, se explicará cómo realizar este proceso. 

 

4.3. Accionamiento de los pedales 

Si se observa el modelo desde una vista de perfil, puede verse que inicialmente la 

bicicleta se encuentra suspendida en el aire, a una distancia de unos pocos 

milímetros del suelo. Esto se ha hecho así debido a la superficie irregular de la rueda, 

ya que al no ser una superficie lisa se vuelve demasiado complejo establecer un 

contacto perfecto entre el suelo y las ruedas. Por ese motivo, se decide dejar que 

caiga desde unos milímetros de altura para evitar problemas de choques de sólidos. 

Por lo tanto, debido a esta pequeña distancia, es recomendable no empezar el 

giro de los pedales hasta que se establezca contacto con el suelo. Si se simula el 

modelo tal cual está, puede observarse que a los 0.25 segundos de la simulación, la 

bicicleta ya está en contacto perfecto con el suelo. Por lo tanto, se decide comenzar 

el pedaleo a los 0.5 segundos de haber comenzado. 

Para generar el movimiento de los pedales hay varias alternativas: 

1. Crear fuerzas en los pedales simulando los pies del ciclista, alternando 

esas fuerzas y haciendo que cada vez actúe una en función de la posición 

de los pedales. Esta opción sería más realista, pero implicaría la presencia 

de fuerzas desequilibrantes alternantes en el modelo, lo que obligaría a 

compensarlas con otras fuerzas ejercidas en otro punto, lo cual complica 

el modelo demasiado y se escapa del objetivo de este proyecto. 

2. Introducir un movimiento rotatorio en el par R_Pedal_Cuadro mediante 

el menú Motions > Joint Motions > Rotational Joint Motion. 

 

Tras analizar las dos alternativas, se decide optar por la segunda, ya que simplifica 

el modelado considerablemente y los resultados obtenidos son muy similares a los 

que se obtendrían utilizando el primer método. 
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4.3.1. Movimiento rotatorio en el par de los pedales 
Para generar un movimiento en un par de rotación, se hace click en el menú 

Motions > Joint Motions > Rotational Joint Motion, y se hace click en el par donde se 

desea aplicar, que en este caso es el par de rotación R_Pedal_Cuadro. El movimiento 

habrá aparecido en el árbol de entidades, en el apartado Motions, donde se puede 

renombrar como Mov_Rotatorio_Pedales. 

Creado el movimiento, es necesario establecer las condiciones del mismo. Para 

ello se hace doble click en el Motion recién creado y se elige el método de 

movimiento, que puede ser un desplazamiento (Displacement), una velocidad 

(Velocity) o una aceleración (Acceleration). En este caso, se elige una velocidad. 

Una vez establecido el tipo de movimiento, se debe decidir cómo va a ser ese 

movimiento. Para ello se puede introducir un valor constante o una función, como 

se hará en este caso. Para introducir la función se hace click en el botón con tres 

puntos suspensivos en el campo Function (time), y se introduce la función deseada 

en el campo que aparece. En este caso la función será la siguiente: 

𝐹𝑢𝑛𝑐𝑖ó𝑛 𝑑𝑒 𝑣𝑒𝑙𝑜𝑐𝑖𝑑𝑎𝑑 = 𝑆𝑇𝐸𝑃 (𝑡𝑖𝑚𝑒, 0, 0, 0.5, 0) + 𝑆𝑇𝐸𝑃 (𝑡𝑖𝑚𝑒, 0.5, 0, 7, −360𝑑) 

ECUACIÓN 7: 'FUNCIÓN DE VELOCIDAD PARA EL PAR R_PEDAL_CUADRO' 

 

 

ILUSTRACIÓN 59: 'FUNCIÓN DE VELOCIDAD DEFINIDA EN ADAMS' 

 

La función queda definida en dos pasos debido a la pequeña separación que hay 

entre la bicicleta y el suelo, tal y como se ha explicado en el apartado anterior. 
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La función STEP tiene la siguiente estructura: 

𝑆𝑇𝐸𝑃 (𝑥, 𝑥0, ℎ0, 𝑥1, ℎ1) 

ECUACIÓN 8: 'ESTRUCTURA DE LA FUNCIÓN STEP' 

 

Como se observa, la función tiene 5 variables cuyo formato es el siguiente: 

• 𝑥 → la variable 

• 𝑥0 → valor inicial de la variable 

• ℎ0 → valor de la función cuando 𝑥 = 𝑥0 

• 𝑥1 → valor final de la variable 

• ℎ1 → valor de la función cuando 𝑥 = 𝑥1 

 

En este caso, la variable escogida es el tiempo, y el parámetro donde incide 

directamente la función es la velocidad. Si se analiza la función escogida con 

detenimiento, se observan dos intervalos diferenciados: el de 0 a 0.5 segundos, y el 

de 0.5 a 7 segundos. En el primer intervalo, la velocidad de rotación del par es nula, 

ya que es necesario darle un margen para que la bicicleta llegue a tocar el suelo. En 

el segundo intervalo, de 0.5 a 7 segundos, se decide aumentar la velocidad de 

rotación poco a poco para evitar deslizamientos, es decir, evitar que la rueda trasera 

“derrape” y los resultados se vean alterados. Por lo tanto, la velocidad aumenta 

progresivamente hasta que a los 7 segundos la velocidad es de 360º/s, es decir, una 

vuelta completa sobre su eje por cada segundo transcurrido. Estas condiciones se 

darán hasta el final del recorrido, por lo que se mantendrá constante esta velocidad. 
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5. PROCESO DE SIMULACIÓN 

5.1. Ajuste de la simulación 

Tras haber definido todos los parámetros del modelo, se puede proceder a 

realizar las simulaciones pertinentes. 

Como el modelo tiene cierta complejidad debido al montaje de la cadena y las 

ruedas dentadas, es necesario modificar ligeramente unos parámetros a la hora de 

realizar la simulación, ya que si no el proceso es demasiado costoso, llegando a más 

de media hora de cálculos para quince segundos de simulación. 

Para ajustar la simulación, se hace click en el apartado Simulation > Simulate > 

Run an Interactive Simulation. En la ventana emergente se controlan las opciones 

de la simulación. Se establecerá un tiempo de 15 segundos para dejar que la bicicleta 

recorra toda la distancia del suelo, y se establecerá un tamaño Step Size de 0.01. Por 

último, y más importante, se desactiva la casilla Update graphics display, ya que esta 

opción hace que se previsualice el modelo mientras se realiza la simulación, lo que 

causa esa larga duración. 

Una vez establecidos los parámetros, la ventana queda de la siguiente manera: 

 

ILUSTRACIÓN 60: 'VENTANA DE LA SIMULACIÓN' 
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Tras esto, ya se puede proceder a realizar la simulación pulsando el botón Play 

de color verde. El proceso llevará aproximadamente 7 minutos, una reducción 

bastante notoria comparada con los 30 minutos comentados anteriormente. 

Para visualizar la simulación, se hace click en el botón central de la parte inferior 

(Switch to animation controls) y se maneja con los botones de la parte superior. Es 

en esta ventana donde podrá visualizarse la simulación completa. 

 

ILUSTRACIÓN 61: 'CONTROLES DE ANIMACIÓN DE LA SIMULACIÓN ' 

 

5.2. Ventanas de medida de parámetros 

Tras la simulación, se pueden analizar una infinidad de parámetros de cualquier 

tipo. En este caso, algunos son muy interesantes y son el objeto principal de estudio, 

por lo que se crearán las ventanas de medida correspondientes. 

Para generar una medición, se puede hacer de varias maneras. La más sencilla es 

buscando el objeto que se desea estudiar y haciendo click sobre él con el botón 
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derecho y luego en Measure. En la ventana emergente se ajustan los parámetros de 

la medición, que variarán dependiendo de la medida que se quiera tomar. 

 

ILUSTRACIÓN 62: 'CREACIÓN DE UNA MEDICIÓN' 

 

En este caso, se decide tomar medición de los siguientes parámetros para poder 

compararlos posteriormente: 

Nombre medición Punto / Par Característica 

Vel_lineal_cm Cuadro.cm Velocidad lineal 

Acel_lineal_cm Cuadro.cm Aceleración lineal 

Distancia_Recorrida Cuadro.cm Desplazamiento lineal 

Vel_ang_Pedal R_Pedal_Cuadro Velocidad angular 

Acel_ang_Pedal R_Pedal_Cuadro Aceleración angular 

Vel_ang_RTras R_RTras_Cuadro Velocidad angular 

Acel_ang_RTras R_RTras_Cuadro Aceleración angular 

bushing_i.Total_Force_At_Location.Mag Link_1 Fuerza en el eslabón 

TABLA 10: 'MEDICIONES TOMADAS EN LA SIMULACIÓN' 
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5.3. Postprocesado de resultados 

Las mediciones se calculan automáticamente tras cada simulación. Para 

visualizarlas puede hacerse a través del menú View > Measure… y seleccionando la 

que se quiera visualizar. También se puede entrar en el menú del post-procesador 

mediante la tecla F8 para generar gráficos más detallados, incluso exportar los 

resultados y analizarlos, por ejemplo, con una hoja de Excel. Esta ventana permite 

exportar a vídeo las simulaciones, haciendo click con el botón derecho en la ventana 

y en Load Animation. Se establecen las condiciones, se pulsa el botón rojo y se 

simula. Al acabar, se habrá generado un vídeo en formato .avi en la ruta de trabajo. 

 

ILUSTRACIÓN 63: 'POSTPROCESADO EN VÍDEO' 

 

Como en este caso se obtienen algunas mediciones erróneas en ciertos puntos 

que impiden visualizar el resto de datos correctamente, se decide exportar los 

resultados numéricos para procesarlos con Excel y así poder eliminar dichos puntos 

erróneos y visualizar mejor los gráficos. Para ello se dibujan las gráficas en el menú 

de post-procesado, marcando la opción Plotting de la esquina superior izquierda. Se 

selecciona como Source la opción Measures, y seleccionando la medida que se quiera 

dibujar se hace click en Add Curves y aparecerá su gráfica. Para exportar estos datos 

se hace click en el menú File > Export > Numeric Data…, y en la ventana emergente 

se escribe el nombre del archivo y se seleccionan los datos a exportar, que serán las 

líneas correspondientes a plot_1. Con el documento exportado, se pueden procesar 

los datos mediante una hoja de cálculo de Excel. 
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6. RESULTADOS OBTENIDOS Y ANÁLISIS 

A continuación, se detallarán los resultados obtenidos en las sucesivas 

simulaciones del modelo en los distintos escenarios. Destacar que, para la correcta 

visualización de los gráficos, ha sido necesario ajustar la escala y omitir ciertos 

puntos erróneos que daban lugar a resultados incorrectos. 

 

6.1. Escenarios 1, 2 y 3: pendiente del terreno del 0% 

Los tres primeros escenarios a analizar son aquellos cuya pendiente de 

inclinación del terreno es de cero grados. A continuación, se detallan los gráficos 

obtenidos de los datos exportados de Adams para su análisis: 

 

6.1.1. Parámetros del centro de masas del sistema 

 

ILUSTRACIÓN 64: 'VELOCIDAD LINEAL DEL CENTRO DE MASAS (PENDIENTE 0%)' 

 

Debido a la variación del tamaño del piñón, la relación de transmisión es diferente 

entre unos desarrollos y otros y, como consecuencia, la velocidad lineal del conjunto 

cuando se estabiliza la rotación de los pedales es diferente para cada desarrollo, 

siendo mayor cuanto más pequeño es el piñón de la rueda trasera. 
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La velocidad de la bicicleta es igual a la velocidad lineal de un punto exterior de 

la rueda trasera. Por lo tanto, siguiendo el criterio de que la velocidad lineal en la 

cadena se mantiene y, por lo tanto, el plato y el piñón tienen esa misma velocidad, 

puede calcularse la velocidad angular del piñón y a partir de ella calcular la velocidad 

lineal de la bicicleta. Por ejemplo, para el caso del piñón de 10 dientes: 

𝑣𝑝𝑙𝑎𝑡𝑜 = 𝜔𝑝𝑙𝑎𝑡𝑜 · 𝑟𝑝𝑙𝑎𝑡𝑜 = 2𝜋 · 0,0493 = 0,3098
𝑚

𝑠
 

𝜔𝑝𝑖ñó𝑛 · 𝑟𝑝𝑖ñó𝑛 = 𝜔𝑝𝑙𝑎𝑡𝑜 · 𝑟𝑝𝑙𝑎𝑡𝑜 → 𝜔𝑝𝑖ñó𝑛 =
0,3098

0,0147
= 21,04

𝑟𝑎𝑑

𝑠
 

𝑉𝑒𝑙𝑜𝑐𝑖𝑑𝑎𝑑 𝑏𝑖𝑐𝑖𝑐𝑙𝑒𝑡𝑎 = 𝑣𝑟𝑢𝑒𝑑𝑎 = 𝜔𝑝𝑖ñó𝑛 · 𝑟𝑟𝑢𝑒𝑑𝑎 = 21,04 · 0,3302 = 6,95
𝑚

𝑠
 

ECUACIÓN 9: 'CÁLCULO DE LA VELOCIDAD LINEAL DE LA BICICLETA' 

Nota: la velocidad angular del plato es de 2π rad/s, y los radios se extraen de las 

ilustraciones 48 y 49. El radio de la rueda es 13 pulgadas = 0,3302 m 

 

Procediendo de la misma manera pueden calcularse las otras velocidades lineales. 

Para el caso de la aceleración lineal del sistema, ocurre algo particular que puede 

verse reflejado en el siguiente gráfico: 

 

ILUSTRACIÓN 65: 'ACELERACIÓN LINEAL DEL CENTRO DE MASAS (PENDIENTE 0%)' 
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Como se puede observar, los datos obtenidos son muy dispersos y no dejan lugar 

a conclusiones razonables. El motivo de esta gran dispersión de los datos es la 

acumulación de errores por varios motivos, pero principalmente dos: 

• Transmisión por cadena: el módulo Machinery para la creación de la 

cadena en MSC Adams introduce pequeños errores en el cálculo que se 

van acumulando debido a la gran cantidad de cálculos requeridos para 

realizar la simulación. 

• Contacto entre las ruedas y el suelo: para que las ruedas se desplacen 

correctamente sobre el terreno, es necesario crear una fuerza de tipo 

contacto en Adams. Este tipo de fuerzas son muy complejas y requieren 

de muchos cálculos que también inducen a errores. 

La acumulación de errores debido a estos dos motivos, hace que los datos 

obtenidos sean muy dispersos y no proporcionen una solución clara, por lo que no 

son útiles en este caso. 

Por último, puede analizarse también la distancia recorrida por la bicicleta 

durante la simulación: 

 

ILUSTRACIÓN 66: 'DISTANCIA RECORRIDA POR LA BICICLETA (PENDIENTE 0%)' 

 

Igual que ocurre con la velocidad de traslación, la distancia recorrida es mayor 

cuanto mayor es la velocidad del sistema. Durante los primeros 7 segundos, mientras 
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la bicicleta está acelerando, la distancia sigue una tendencia exponencial, hasta que 

con la estabilización de la velocidad la distancia recorrida aumenta de forma lineal 

y regular. 

 

6.1.2. Parámetros de los pedales 

 

ILUSTRACIÓN 67: 'VELOCIDAD ANGULAR DE LOS PEDALES (PENDIENTE 0%)' 

 

Observando ahora el comportamiento de los pedales, se confirma lo que cabía 

esperar. Como la ecuación del movimiento se ha introducido como una variación de 

la velocidad, este parámetro sigue una tendencia exponencial al principio y tiende a 

ser lineal después, con un punto de inflexión entre ambas tendencias. Como se 

observa, en los tres desarrollos el comportamiento es exactamente el mismo, ya que 

el movimiento se ha impuesto directamente como una rotación en los pedales y las 

condiciones de contorno no variarán este comportamiento. 

Si el movimiento se hubiera creado mediante una pareja de fuerzas sobre los 

pedales simulando los pies del ciclista, esta progresión no sería igual para los tres 

desarrollos, ya que para una misma fuerza de accionamiento cada uno tendría una 

distinta velocidad de rotación. 
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En cuanto a la aceleración angular de los pedales existen pequeños errores en los 

cálculos, pero en este caso los resultados sí que dan lugar a la extracción de 

conclusiones, ya que a pesar de haber puntos dispersos el gráfico sigue una 

tendencia claramente apreciable: 

 

ILUSTRACIÓN 68: 'ACELERACIÓN ANGULAR DE LOS PEDALES (PENDIENTE 0%)' 

 

En este caso, puede observarse cómo los pedales aceleran entre 0 y 7 segundos 

para alcanzar la velocidad exigida de 2π rad/s, con un punto de inflexión a mitad del 

recorrido. Después, a pesar de los errores obtenidos en muchos resultados, se 

observa que el gráfico tiende a ser nulo, tal y como cabe esperar al tener el sistema 

una velocidad constante a partir de los 7 segundos de simulación. 

 

6.1.3. Parámetros de la rueda trasera 
En tercer lugar, se procede a analizar la rueda trasera. En este caso, la velocidad 

angular de la rueda es la misma que la que lleva el piñón, por lo que sigue la regla de 

la velocidad lineal constante durante el recorrido de la cadena, tal y como se ha 

calculado en el apartado 6.1.1..  

Los resultados obtenidos para la velocidad angular son los siguientes: 
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ILUSTRACIÓN 69: 'VELOCIDAD ANGULAR DE LA RUEDA TRASERA (PENDIENTE 0%)' 

 

En este caso, a pesar de que la velocidad angular de los pedales es la misma en los 

tres desarrollos, existe una diferencia bastante visible en la velocidad angular de la 

rueda trasera, debido a la diferencia de tamaño de los tres piñones. De nuevo, se 

obtiene una velocidad mayor cuanto menor es el tamaño del piñón. 

 

Por último, en cuanto a la aceleración angular ocurre lo mismo que en el caso de 

la aceleración lineal del centro de masas del conjunto y no da lugar a conclusiones 

debido a los errores acumulados y la disparidad de los resultados obtenidos: 

 

ILUSTRACIÓN 70: 'ACELERACIÓN ANGULAR DE LA RUEDA TRASERA (PENDIENTE 0%)' 
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6.1.4. Parámetros en la transmisión 
Por último, se procede a analizar los resultados obtenidos en las mediciones de 

la transmisión. Es en este punto donde se aprecian las mayores diferencias. 

En una cadena de transmisión, el punto de rotura en el que los eslabones se 

separan y la cadena se considera inservible es el denominado como Bushing, que es 

el manguito de unión entre dos eslabones sucesivos de la cadena. Por lo tanto, una 

buena medición que se puede realizar es la de la fuerza total que actúa en ese punto, 

y resulta lo siguiente: 

 

ILUSTRACIÓN 71: 'MEDIDA DE LA FUERZA EN EL ESLABÓN DE UNIÓN' 

 

Considerando el punto de medida coloreado en color rojo en la cadena (en la 

parte superior del plato en la imagen), se aprecia que la fuerza oscila en función de 

la posición del eslabón. Así, cuando el eslabón es atacado por el engranaje, la fuerza 

que soporta comienza a ascender hasta alcanzar su máximo justo cuando el eslabón 

pasa de “entrar” en el engranaje a “salir”, justo en la mitad del recorrido de la cadena 

sobre la rueda dentada, y desciende a partir de ese punto hasta alcanzar un valor 

que parece ser constante y no nulo debido a las tracciones en la cadena. 

Si se comparan los resultados obtenidos para los tres desarrollos estudiados, se 

obtienen los siguientes resultados: 
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ILUSTRACIÓN 72: 'FUERZA ACTUANTE EN EL ESLABÓN DE LA CADENA (PENDIENTE 0%)' 

 

Observando con detenimiento el gráfico, puede verse que el comportamiento 

oscilatorio se repite en los tres casos. Sin embargo, se aprecian dos diferencias 

claras: 

• Existe un desfase temporal debido a la diferencia de tamaño del piñón, que 

hace que el eslabón de la cadena sea atacado antes o después en función 

del tamaño del mismo. 

• Cuando el eslabón es atacado por el piñón, la fuerza que se ejerce es mayor 

cuanto mayor es el tamaño del piñón, mientras que mantiene un valor 

máximo constante en los tres casos cuando es atacada por el plato. 

A pesar de que la velocidad de rotación de la rueda es mayor cuanto menor es el 

tamaño del piñón, se observa que la fuerza que se ejerce sobre el eslabón al pasar 

por el piñón pequeño es menor que cuando pasa por el piñón más grande, a pesar 

de que pueda parecer que ocurre lo contrario en la realidad. Esto se debe 

principalmente al tamaño del piñón y al recorrido que debe realizar la cadena. 

También se observa que cuando el eslabón no es atacado, la fuerza ejercida en el 

desarrollo con el piñón más grande es algo mayor a las otras dos, aunque la 

diferencia no es tan notable como en el caso de los piñones. 
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6.2. Escenarios 4, 5 y 6: pendiente del terreno del 12% 

De igual manera que se ha hecho para los tres primeros escenarios, se procede 

ahora a analizar detalladamente los tres últimos, con una pendiente del terreno del 

12%. 

Como el movimiento de la bicicleta se ha introducido como una rotación en los 

pedales con variación progresiva de la velocidad, algunos de los parámetros se 

mantienen igual que en los tres primeros escenarios, tal y como se verá a 

continuación. 

 
6.2.1. Parámetros en el centro de masas del sistema 

Para el caso de la velocidad lineal del sistema, pueden apreciarse diferencias con 

los tres primeros escenarios: 

 

ILUSTRACIÓN 73: 'VELOCIDAD LINEAL DEL CENTRO DE MASAS (PENDIENTE 12%)' 

 

Para el caso del desarrollo con 50 dientes en el pedal, se observa que los 
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bicicleta comienza a deslizar, hasta que el sistema comienza a caer hacia atrás 

debido a la gran velocidad de rotación y la fuerza necesaria para mover el desarrollo, 

que hace que la fuerza ejercida supere a la fuerza de rozamiento, por lo que no puede 

mantener el contacto y comienza a “derrapar”. Por ese motivo, la velocidad pasa a 

ser negativa cuando el sistema se mueve en sentido contrario. Se observa que este 

comportamiento aparece antes cuanto más pequeño es el piñón. 

En cuanto a la aceleración lineal, el error acumulado hace que de nuevo los datos 

sean muy dispersos y no den lugar al análisis y a la extracción de conclusiones: 

 

ILUSTRACIÓN 74: 'ACELERACIÓN LINEAL DEL CENTRO DE MASAS (PENDIENTE 12%)' 

 

En tercer lugar, en la distancia recorrida por el sistema ocurre lo mismo que con 

la velocidad lineal, y es que comienza a descender debido al deslizamiento de la 

rueda y la caída del sistema: 

 

ILUSTRACIÓN 75: 'DISTANCIA RECORRIDA POR EL SISTEMA (PENDIENTE 12%)' 
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6.2.2. Parámetros en los pedales 
Analizando ahora el comportamiento de los pedales, se observan unos valores 

idénticos a los de los tres primeros escenarios por el motivo ya comentado: 

 

ILUSTRACIÓN 76: 'VELOCIDAD ANGULAR DE LOS PEDALES (PENDIENTE 12%)' 

 

 

ILUSTRACIÓN 77: 'ACELERACIÓN ANGULAR DE LOS PEDALES (PENDIENTE 12%)' 
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A pesar del error acumulado en la aceleración, puede verse la tendencia de la 

curva y su similitud con la del caso con pendiente horizontal. 

 
6.2.3. Parámetros en la rueda trasera 

En tercer lugar, analizando el comportamiento de los resultados en la rueda 

trasera se observa el mismo comportamiento que en los pedales, y los resultados 

obtenidos son los mismos que para el primer caso: 

 

ILUSTRACIÓN 78: 'VELOCIDAD ANGULAR DE LA RUEDA TRASERA (PENDIENTE 12%)' 

 

ILUSTRACIÓN 79: 'ACELERACIÓN ANGULAR DE LA RUEDA TRASERA (PENDIENTE 12%)' 
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Nuevamente, la disparidad de los datos en la aceleración no da lugar a 

conclusiones. 

 
6.2.4. Parámetros en la transmisión 

En último lugar, se procede a analizar la transmisión. De igual manera que ocurría 

en los tres primeros casos, se observa que la fuerza actuante en el eslabón de la 

cadena varía en función de la posición de la misma. Así, la fuerza es máxima cuando 

el eslabón es atacado por el plato o el piñón y desciende mientras se encuentra en 

el recorrido entre ambas ruedas dentadas. 

También se observa una diferencia entre cada desarrollo, siendo menor la fuerza 

máxima cuanto menor es el tamaño del piñón: 

 

ILUSTRACIÓN 80: 'FUERZA ACTUANTE EN EL ESLABÓN DE LA CADENA (PENDIENTE 12%)' 

 

Se observa que los datos obtenidos y su magnitud son iguales que en el caso de 

pendiente horizontal, debido a que el movimiento ha sido introducido mediante una 

rotación y no mediante una fuerza en los pedales como habría ocurrido en la 

realidad. 
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7. CONCLUSIONES DEL PROYECTO Y DESARROLLOS FUTUROS 

La elaboración de este proyecto ha sido una tarea laboriosa a la par que 

entretenida. Se ha podido observar el comportamiento de algo tan cotidiano como 

una bicicleta y que parece complejo de entender a simple vista mediante elementos 

gráficos muy visuales. 

Por un lado, se observa que cuanto más pequeño es el piñón, mayor es la 

velocidad que adquiere el conjunto. Por otro lado, en una situación en la que hay que 

afrontar una pendiente del terreno, es más conveniente utilizar desarrollos más 

grandes para no perder el contacto con el suelo y no tener problemas de 

deslizamiento, como se ha visto que ocurre en el caso de los desarrollos de 10 y 24 

dientes en el piñón. 

Por último, se observa que la fuerza que actúa en la cadena varía en función del 

desarrollo, permitiendo llegar a determinar en qué situaciones rompería y cómo se 

podría evitar teniendo un conocimiento sobre el comportamiento del sistema de 

transmisión. 

Es importante destacar también que este proyecto queda abierto a futuros 

desarrollos más complejos, por ejemplo: 

• Modelar la ecuación de movimiento como una fuerza actuante en cada 

pedal simulando los pies del ciclista y no como una rotación fija. Esto haría 

que las fuerzas fueran diferentes y que las velocidades angulares y lineales 

variaran en función de la pendiente del terreno, cosa que no ha ocurrido 

al aplicar directamente el movimiento. 

• Analizar qué podría ocurrir al cambiar el tamaño del plato y no solamente 

el del piñón, ya que en este análisis de ha optado por utilizar un único 

tamaño de plato. 

• Cambiar las condiciones del terreno para adaptarlo a posibles cambios 

climatológicos, por ejemplo, variando el coeficiente de rozamiento 

simulando un suelo mojado o embarrado. 

• Estudiar el comportamiento con pendientes más pronunciadas. 
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A pesar de todas estas situaciones posibles, se decide dejar el estudio aquí 

debido a que someterlo a otros escenarios podría dar muchos resultados que 

podrían utilizarse para otros estudios, pero es necesario ponerle punto y aparte a 

este proyecto. 

En definitiva, ha sido un proyecto bonito y práctico que deja una buena base 

para seguir ampliando futuros análisis.  

 

Tras todo esto, aquí culminan cuatro años inolvidables de carrera universitaria. 

Por un lado, me llevo una gran experiencia y unos conocimientos que difícilmente 

podría haber aprendido en cualquier otro sitio y que, muy probablemente, marcarán 

el rumbo del resto de mi vida. Y lo más importante de todo, me llevo unos amigos 

para toda la vida. 
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1. CONDICIONES DE EJECUCIÓN DEL PROYECTO 

El pliego de condiciones es un documento que recoge los requisitos técnicos y/o 

legales por los que debe regirse el proyecto en cuestión, para garantizar que el 

mismo se desarrolla correctamente. 

El proyecto consiste en el modelado y simulación dinámica de una bicicleta 

convencional y su sistema de transmisión de movimiento. Como no se han realizado 

ensayos experimentales en laboratorio, no será necesario incluir normativa de 

seguridad ni condiciones facultativas. Por lo tanto, podrá dividirse el documento en 

dos partes diferenciadas: condiciones de los equipos utilizados y condiciones del 

modelo. 

 

1.1. Condiciones de los equipos utilizados 

Para la realización de este proyecto se han necesitado dos equipos informáticos 

y dos programas principales, uno de simulación y otro de modelado 3D, por lo que 

se distinguirá en dos subapartados. 

 
1.1.1. Hardware 

Los equipos utilizados en el desarrollo de este proyecto son un ordenador portátil 

de uso personal y un equipo disponible en la ETSID de la UPV, en concreto, en el 

aula Alemania. 

▪ Equipo personal: utilizado para el desarrollo de la memoria del proyecto y 

gran parte del modelado de la bicicleta, excepto el sistema de transmisión. 

• Ordenador portátil Asus K55VM 

• Procesador Intel Core i7 3610QM 2.3GHz 

• Tarjeta gráfica Nvidia GeForce 630M 2GB 

• Memoria RAM 8GB DDR3 

• Disco duro SSD Crucial MX100 120GB 

• Sistema operativo Windows 8.1 

• Teclado, ratón y monitor (15.6” 1366x768) integrados 
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▪ Equipo disponible en la ETSID: utilizado para el modelado del sistema de 

transmisión de la bicicleta y la simulación final con las condiciones 

impuestas. Ha sido necesario debido a las restricciones presentes en la 

versión de estudiante de MSC Adams View instalada en el equipo personal. 

Instalado en el aula Alemania de la escuela. 

• Ordenador de sobremesa HP ProDesk 490 G3 Microtower 

• Procesador Intel Core i7 6700 3.4GHz 

• Tarjeta gráfica Nvidia GeForce GT 730 2GB 

• Memoria RAM 8GB DDR4-SDRAM 

• Disco duro 1TB 

• Sistema operativo Windows 10 Pro 

• Teclado, ratón y monitor (HP L1950) externos 

 

1.1.2. Software 
Para el desarrollo del proyecto se ha utilizado el siguiente software: 

▪ MSC Adams View: software principal del proyecto. Utilizado para la 

importación del modelo CAD, la creación de las condiciones de contorno, 

ajuste de densidades mediante la versión para estudiantes, y creación de la 

cadena de transmisión, simulación final y extracción de datos mediante la 

versión completa con licencia. 

▪ SolidWorks 2018: utilizado para la creación de los planos del modelo a partir 

de exportaciones en formato IGES (.igs) provenientes del modelo de MSC 

Adams. 

▪ Microsoft Word y Excel 2016: para la redacción de los documentos 

explicativos del proyecto y la realización de cálculos y gráficos. 

 

1.2. Condiciones del modelo  

Para la importación del modelo en el entorno de MSC Adams, es necesario 

establecer unas condiciones sobre las que se sostendrá el modelo y que implicarán 

que los resultados obtenidos sean correctos y no den valores dispares. Dichas 

condiciones son las que se enumeran a continuación: 
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▪ Modelo CAD a utilizar: disponible en la librería GrabCAD, denominado 

“BICYCLE ASSEMBLY” y cuyo autor es el usuario “Yuvan”. 

▪ Modificaciones del modelo: se modifica la pieza que compone los pedales y 

el eje de pedalier para eliminar las ruedas dentadas modeladas, ya que no se 

utilizarán. 

▪ Densidades impuestas: como el cuadro y la horquilla son macizos, su 

densidad calculada será de 1090 kg/m3 para lograr un peso realista. En 

cuanto a las ruedas y el sillín la densidad será de 950 kg/m3. Los pedales 

serán de acero con densidad 7801 kg/m3. 

▪ Plato: se impondrá para la transmisión un plato de 34 dientes y 6 mm de 

espesor, así como el acero para el material. El resto de dimensiones serán 

calculadas por MSC Adams. 

▪ Piñones: se considerarán tres tamaños de piñón: 10 dientes, 24 dientes y 50 

dientes, todos ellos con grosor de 6 mm y como material acero. 

▪ Distribución del peso del ciclista: se considerará una masa promedio de 75 

kg para un adulto, y su distribución será de un 60% sobre el sillín (45 kg) y 

un 40% sobre el manillar (30 kg), aplicados como masas puntuales sobre los 

cuerpos. 

▪ Movimiento del modelo: se impondrá la función de movimiento como una 

variación progresiva de la velocidad de rotación de los pedales, siendo nula 

entre 0 y 0.5 segundos y de 360 grados/s a los 7 segundos de la simulación, 

con un aumento progresivo entre el intervalo de 0.5 a 7 segundos. 

▪ Pares establecidos: se considerarán pares de rotación para ambas ruedas, 

pedales y horquilla, todos ellos en relación al manillar. En cuanto al sillín, se 

establecerá un par fijo. 

▪ Contacto del modelo y el suelo: se creará un contacto con fricción de 

Coulomb entre las ruedas y el suelo. 

▪ Fijación del suelo: el suelo se anclará a la barra fija con un par de rotación 
fijo. Su masa será calculada tras crear los contactos con las ruedas. 
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1. PRESUPUESTO DEL PROYECTO 

Tras la realización completa del proyecto, es necesario establecer un 

presupuesto definido por el proyectista, atendiendo a las condiciones del propio 

proyecto y a las condiciones legales que se puedan imponer. Se desglosará el 

presupuesto en varios apartados que se detallarán a continuación, para finalmente 

concluir con el coste final del proyecto, incluyendo todos los apartados anteriores. 

Destacar que en los costes no se incluye el impuesto de valor añadido (IVA) hasta el 

último de los apartados. 

 

1.1. Mano de obra 

Para calcular el presupuesto de la mano de obra del ingeniero, debe tenerse en 

cuenta el salario de un graduado en ingeniería mecánica establecido por el BOE, en 

concreto, para el Convenio de Oficinas y Despachos de la provincia de Valencia en 

el año 2018. Según la tabla salarial del convenio, el salario para un Titulado Medio o 

Diplomado (Grupo II, Nivel II) es de 1.408,82 €/mes. Además, teniendo en cuenta 

que el cómputo del convenio es de 1.767 horas anuales de trabajo efectivo, el coste 

por hora será: 

𝐶𝑜𝑠𝑡𝑒 𝑝𝑜𝑟 ℎ𝑜𝑟𝑎 =
1.408,82

€
𝑚𝑒𝑠 · 12 𝑚𝑒𝑠𝑒𝑠

1.767 ℎ𝑜𝑟𝑎𝑠
= 9,57 €/ℎ𝑜𝑟𝑎 

ECUACIÓN 10: 'COSTE POR HORA TRABAJADA SEGÚN EL BOE' 

 

También hay que tener en cuenta los pagos a la Seguridad Social por la labor del 

proyectista. Consultando la web de la Seguridad Social, se establece una base de 

cotización mínima para el grupo 2 de 994,20 €/mes. Calculando de manera análoga 

al punto anterior, el coste por hora de la Seguridad Social es de: 

𝐶𝑜𝑠𝑡𝑒 𝑆𝑒𝑔𝑢𝑟𝑖𝑑𝑎𝑑 𝑆𝑜𝑐𝑖𝑎𝑙 =
994,20

€
𝑚𝑒𝑠 · 12 𝑚𝑒𝑠𝑒𝑠

1.767 ℎ𝑜𝑟𝑎𝑠
= 6,75 €/ℎ𝑜𝑟𝑎 

ECUACIÓN 11: 'COSTE DE LA SEGURIDAD SOCIAL' 
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Por último, el BOE añade que se establecen dos pagas extra anuales para el 

Convenio de Oficinas y Despachos. Por lo tanto, cada una de esas pagas será de 

1.408,82 €, lo que se traduce en un coste por hora de: 

𝐶𝑜𝑠𝑡𝑒 𝑝𝑎𝑔𝑎𝑠 𝑒𝑥𝑡𝑟𝑎 =
1.408,82

€
𝑝𝑎𝑔𝑎

· 2 𝑝𝑎𝑔𝑎𝑠

1.767 ℎ𝑜𝑟𝑎𝑠
= 1,59 €/ℎ𝑜𝑟𝑎 

ECUACIÓN 12: 'COSTE PAGAS EXTRA ' 

 

Por lo tanto, el coste de la mano de obra directa será: 

Concepto Cantidad Unidades Precio unidad 
(€) 

Importe neto 
(€) 

Realización del proyecto 300 h 9,57 2.871,00 

Seguridad Social 300 h 6,75 2.025,00 

Pagas extra 300 h 1,59 477,00 

Total - - - 5.373,00 

TABLA 11: 'PRESUPUESTO MANO DE OBRA DIRECTA' 

 

Como en el proyecto solo ha participado el ingeniero, no existen costes por mano 

de obra indirecta, por lo que el coste total de la mano de obra es el establecido en la 

tabla anterior. 

 

1.2. Gastos generales y derivados 

En la parte de gastos generales y derivados se incluyen aquellos gastos que no 

vengan directamente de la mano de obra ni de la amortización. Por lo tanto, incluye 

gastos de mantenimiento (luz consumida por los equipos, agua, etc.) y gastos de 

consumibles, que en este caso son simplemente material de oficina. Los gastos de 

mantenimiento pueden calcularse como una parte porcentual de la mano de obra 

del proyecto, que puede establecerse como un 2% de la misma. En cuanto a los 

consumibles, se tendrá en cuenta el precio establecido por el comerciante que 

venda cada uno de ellos. 
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Por lo tanto, teniendo en cuenta estas aclaraciones, los gastos generales del 

proyecto quedan de la siguiente manera: 

Concepto Cantidad Unidades 
Precio unidad 

(€) 
Importe neto 

(€) 

Impresión en color 
y encuadernado 

1 documento 23,14 23,14 

DVD 1 disco 2,07 2,07 

Luz, agua y 
derivados 2 

% de mano de 
obra 53,73 107,46 

Total - - - 132,67 

TABLA 12: 'PRESUPUESTO GASTOS GENERALES' 

 

1.3. Software, hardware y amortizaciones 

Para la realización de este proyecto se han utilizado dos programas diferentes: 

MSC Adams View 2017.2 (versión estudiante) para el desarrollo completo del 

proyecto y MSC Adams View 2018 (versión completa) para su posterior análisis, y 

SolidWorks 2018, utilizado para elaborar los planos. Consultando las páginas web de 

ambos programas, se puede encontrar el precio de una licencia: 

• MSC Adams View 2017.2 (estudiante): 0,00 € 

• MSC Adams View 2018 (completo): 1.652,89 € (IVA no inc.) (1 año vida útil) 

• SolidWorks 2018: 5.454,54 € + 1.239,69 €/año (IVA no inc.) (3 años vida útil) 

 

Considerando la vida útil del software antes de quedar desfasado, y teniendo en 

cuenta las horas de utilización durante este proyecto, se calcula la parte 

proporcional de la amortización de ambos programas. A pesar de que el proyecto ha 

costado unas 300 horas de realizar, Adams en versión completa se ha utilizado 

durante 50 horas (2,08 días), mientras que SolidWorks se ha utilizado durante 30 

horas (1,25 días). Como la versión estudiante de Adams no tiene coste, no se calcula. 

Así: 

𝐴𝑚𝑜𝑟𝑡. 𝐴𝑑𝑎𝑚𝑠 =
1.652,89 €

1 𝑎ñ𝑜𝑠 · 12
𝑚𝑒𝑠𝑒𝑠

𝑎ñ𝑜

·
2,08 𝑑í𝑎𝑠

30
𝑑í𝑎𝑠
𝑚𝑒𝑠

= 9,55 € 
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𝐴𝑚𝑜𝑟𝑡. 𝑆𝑜𝑙𝑖𝑑𝑊𝑜𝑟𝑘𝑠 =
5.454,54 €

3 𝑎ñ𝑜𝑠 · 12
𝑚𝑒𝑠𝑒𝑠

𝑎ñ𝑜

·
1,25 𝑑í𝑎𝑠

30
𝑑í𝑎𝑠
𝑚𝑒𝑠

+
1.239,69 €

1 𝑎ñ𝑜 · 12
𝑚𝑒𝑠𝑒𝑠

𝑎ñ𝑜

·
1,25 𝑑í𝑎𝑠

30
𝑑í𝑎𝑠
𝑚𝑒𝑠

= 10,62 € 

ECUACIÓN 13: CÁLCULO AMORTIZACIÓN SOFTWARE' 

 

Por lo tanto, la tabla de costes del software será: 

Concepto Cantidad Unidades 
Precio 

unidad (€) 
Importe 
neto (€) 

Amortización MSC Adams 
View 2017.2 (estudiante) 0,00 días 0,00 0,00 

Amortización MSC Adams 
View 2018 (completo) 2,08 días 4,59 9,55 

Amortización SolidWorks 
2018 1,25 días 8,50 10,62 

Total - - - 20,17 

TABLA 13: 'AMORTIZACIÓN DEL SOFTWARE' 

 

Por otro lado, el equipo personal utilizado para la realización del proyecto incluye 

el paquete de Microsoft Office con todos los programas de ofimática utilizados, así 

como el sistema operativo Windows. Considerando que el equipo costó 550,41 € 

(IVA no inc.) y que la vida útil del hardware es de 5 años, y teniendo en cuenta que 

se ha utilizado durante 220 horas (9,17 días): 

𝐴𝑚𝑜𝑟𝑡. 𝑒𝑞𝑢𝑖𝑝𝑜 𝑝𝑒𝑟𝑠𝑜𝑛𝑎𝑙 =
550,41 €

5 𝑎ñ𝑜𝑠 · 12
𝑚𝑒𝑠𝑒𝑠

𝑎ñ𝑜

·
9,17 𝑑í𝑎𝑠

30
𝑑í𝑎𝑠
𝑚𝑒𝑠

= 2,80 € 

ECUACIÓN 14: 'CÁLCULO AMORTIZACIÓN EQUIPO PERSONAL' 

 

Por otra parte, el equipo utilizado en la ETSID tiene un coste de 748,07 € y se ha 

utilizado durante 80 horas (3,33 días): 

𝐴𝑚𝑜𝑟𝑡. 𝑒𝑞𝑢𝑖𝑝𝑜 𝐸𝑇𝑆𝐼𝐷 =
748,07 €

5 𝑎ñ𝑜𝑠 · 12
𝑚𝑒𝑠𝑒𝑠

𝑎ñ𝑜

·
3,33 𝑑í𝑎𝑠

30
𝑑í𝑎𝑠
𝑚𝑒𝑠

= 1,38 € 

ECUACIÓN 15: 'CÁLCULO AMORTIZACIÓN EQUIPO ETSID' 
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Por lo tanto, en resumen: 

Concepto Cantidad Unidades 
Precio unidad 

(€) 
Importe neto 

(€) 

Amortización 
ordenador Asus K55VM 

9,17 días 0,306 2,80  

Amortización 
ordenador HP ProDesk 

490 G3 MT 
3,33 días 0,414 1,38  

Total - - - 4,18 

TABLA 14: 'AMORTIZACIÓN HARDWARE' 

 

1.4. Resumen de costes totales 

Teniendo en cuenta todos los gastos desglosados en los apéndices anteriores, ya 

se puede proceder a calcular el presupuesto total del proyecto. 

Es importante tener en cuenta que ahora debe aplicarse el 21% de IVA, ya que 

todos los precios comentados anteriormente excluían los impuestos. Por lo tanto, 

tras hacer el desglose de costes, el presupuesto total del proyecto emitido por el 

proyectista ascenderá a: 

Concepto Coste total (€) 

Mano de obra 5.373,00 

Gastos generales 132,67 

Amortización software 20,17 

Amortización hardware 4,18 

Subtotal 5.530,02 

Impuestos (IVA 21%) 1.161,30 

Total 6.691,32 € 

TABLA 15: 'RESUMEN PRESUPUESTO TOTAL' 

 

El coste total del proyecto asciende a seis mil seiscientos noventa y un euros con 

treinta y dos céntimos. 
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Datos de la rueda dentada
Número de dientes

Módulo
Diámetro primitivo
Diámetro exterior

34
2,81

 98,63
100,79

Diámetro de pie 92,13
Radio del diente 48,78

Material Acero
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Datos de la rueda dentada
Número de dientes

Módulo
Diámetro primitivo
Diámetro exterior

10
2,95

29,45
30,59

Diámetro de pie 22,95
Radio del diente 11,96

Material Acero
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Datos de la rueda dentada
Número de dientes

Módulo
Diámetro primitivo
Diámetro exterior

24
2,91

69,72
71,71

Diámetro de pie 63,22
Radio del diente 29,80

Material Acero
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Datos de la rueda dentada
Número de dientes

Módulo
Diámetro primitivo
Diámetro exterior

50
2,90

144,93
147,24

Diámetro de pie 138,43
Radio del diente 89,96

Material Acero
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